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Chapter 1

Using This Guide

About this Guide
Welcome to the Dell SonicWALL SRA User Guide. This document provides information on 
using the Dell SonicWALL SRA user portal called Virtual Office that allows you to create 
bookmarks and run services over the Dell SonicWALL SRA appliance.

Navigate to http://www.sonicwall.com/us/Support.html for the latest version of this manual as 
well as other Dell SonicWALL products and services documentation.

Organization of this Guide
The Dell SonicWALL SRA User Guide organization is structured into the following parts:

Chapter 1 Using this Guide

This chapter provides helpful information for using this guide. It.includes conventions used in 
this guide, information on how to obtain additional product information, and a Quick Access 
Worksheet that you should complete before using the SRA appliance.

Chapter 2 Virtual Office Overview

This chapter provides an overview of new Dell SonicWALL SRA appliance user features, 
NetExtender, File Shares, Secure Virtual Assist, Secure Virtual Access, Secure Virtual Meeting, 
services, sessions, bookmarks, and service tray menu options.

Chapter 3 Using Virtual Office Features

This chapter provides procedures on importing certificates, using Two-Factor authentication, 
and using One-Time Passwords.

Chapter 4 Using NetExtender

This chapter provides procedures on installing, configuring, and using NetExtender.

Chapter 5 Using Virtual Assist

This chapter provides procedures on installing and using Virtual Assist and Virtual Meeting.

Chapter 6 Using File Shares

This chapter provides procedures on using file shares.

Chapter 7 Managing Bookmarks

This chapter provides procedures on configuring bookmarks.

Appendix A Support Information

This appendix provides the Limited Hardware Warranty, End User Licensing Agreement, and 
Dell SonicWALL Support contact information.
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Guide Conventions
The following conventions used in this guide are as follows:

Current Documentation
Check the Dell SonicWALL documentation Web site for the latest versions of all Dell 
SonicWALL product documentation at http://www.sonicwall.com/us/Support.html

Quick Access Work Sheet
Use the Quick Access Work Sheet to collect important information that you will need and should 
be completed by your network Administrator to allow remote users SSL VPN access.

IP Address:___________________________________________________

User Name:___________________________________________________

Password:___________________________________________________

Domain:_____________________________________________________

Convention Use
Bold Highlights dialog box, window, and screen names. Also highlights 

buttons. Also used for file names and text or values you are being 
instructed to type into the interface.

Italic Indicates the name of a technical manual. Also indicates emphasis 
on certain words in a sentence. Sometimes indicates the first 
instance of a significant term or concept.
8 | SRA 7.5 User Guide
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Chapter 2

Virtual Office Overview

This chapter provides an overview of the Dell SonicWALL SSL VPN user portal. It also includes 
an introduction to the SRA appliance and its features and applications. This chapter contains 
the following sections:

• “Virtual Office Overview” section on page 9

• “Browser Requirements” section on page 10

• “Web Management Interface Overview” section on page 12

Virtual Office Overview
Dell SonicWALL SSL VPN Virtual Office provides secure remote access to network resources, 
such as applications, files, intranet Web sites, and email through Web access interface such as 
Microsoft Outlook Web Access (OWA). The underlying protocol used for these sessions is SSL.

With SSL VPN, mobile workers, telecommuters, partners, and customers can access 
information and applications on your intranet or extranet. What information should be 
accessible to the user is determined by access policies configured by the Dell SonicWALL SSL 
VPN Administrator.

Accessing Virtual Office Resources

Remote network resources can be accessed in the following ways:

• Using a standard Web browser - To access network resources, you must log into the SSL 
VPN portal. Once authenticated, you may access intranet HTTP and HTTPS sites, 
offloaded portals, Web-based applications, and Web-based email. In addition, you may 
upload and download files using FTP or Windows Network File Sharing. All access is 
performed through a standard Web browser and does not require any client applications to 
be downloaded to remote users’ machines.

• Using Java thin-client access to corporate desktops and applications – The Dell 
SonicWALL SRA security appliance includes several Java or ActiveX thin-client programs 
that can be launched from within the Dell SonicWALL SRA security appliance. Terminal 
Services and VNC Java clients allow remote users to access corporate servers and 
desktops, open files, edit and store data as if they were at the office. Terminal Services 
provides the ability to open individual applications and support remote sound and print 
services. In addition, users may access Telnet and SSH servers for SSH version 1 (SSHv1) 
and SSH version 2 (SSHv2), from the SSL VPN portal.

• Using the NetExtender SSL VPN client – The Dell SonicWALL SSL VPN network 
extension client, NetExtender, is available through the SSL VPN Virtual Office portal via an 
ActiveX control or through stand-alone applications for Windows, Linux, MacOS, Windows 
Mobile, and Android smartphone platforms. To connect using the SSL VPN client, log into 
the portal, download the installer application and then launch the NetExtender connector to 
establish the SSL VPN tunnel. The NetExtender Android client has a different installation 
process, described in this guide. Once you have set up the SSL VPN tunnel, you can 
access network resources as if you were on the local network. 
Virtual Office Overview | 9



The NetExtender standalone applications are automatically installed on a client system the 
first time you click the NetExtender link in the Virtual Office portal. The standalone client 
can be launched directly from users’ computers without requiring them to log in to the SSL 
VPN portal first.

• Using the SonicWALL Mobile Connect app – SonicWALL Mobile Connect is an app for 
iPhone and iPad that, like NetExtender, uses SSL VPN to enable secure, mobile 
connections to private networks protected by Dell SonicWALL security appliances. For 
information about installing and using SonicWALL Mobile Connect, see the SonicWALL 
Mobile Connect User Guide available on www.sonicwall.com, at:
http://www.sonicwall.com/app/projects/file_downloader/document_lib.php?t=PG&id=482

For SSL VPN to work as described in this guide, the SonicWALL SRA security appliance must 
be installed and configured according to the directions provided in the SonicWALL SRA Getting 
Started Guide for your model.

   Note If your Administrator has Remediation enabled, the warning message “Access is denied by 
Geo IP & Botnet Filter” displays when attempting to accessing remote network resources. A 
browser window is automatically opened to display a CAPTCHA picture and entry field. You 
must perform remediation within the specified time limit before you can login. Refer to the 
SRA 7.5 Administrator’s Guide for details.

Browser Requirements
The following Web browsers are supported for the SSL VPN Virtual Office portal: 

• Internet Explorer 9.0+, 10.0, 11.0

• Firefox 26.0+

• Safari 5.0+

• Chrome 32.0+

For Administrator management interface Web browser compatibility, refer to the Dell 
SonicWALL SSL VPN Administrator Guide.
10 | SRA 7.5 User Guide
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The following table provides specific browser requirements:

Application Proxy

Features & Browser 
Requirements

Windows 
Vista

Windows 
7 

Windows 8 
/ 8.1 Linux MacOS X

NetExtender Browser 
Independent 
(Java 
1.6.0_10+)

Browser Inde-
pendent (Java 
1.6.0_10+)

RDP5 (ActiveX)

RDP5 (Java 1.6.0_10+)

VNC (Java 1.6.0_10+)

Telnet (Java 1.6.0_10+)

SSHv1, SSHv2 
(Java 1.6.0_10+)

HTTP, HTTPS, FTP 
(Browser)

File Sharing (Browser)

File Sharing (Java 
1.6.0_10+)

Citrix (Active X)
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To configure SonicOS SSL VPN firmware, an Administrator must use a Web browser with 
JavaScript, cookies, and SSL enabled.

Virtual Assist is fully supported on Windows platforms. Virtual Assist is certified to work on 
Windows 7, Windows Vista and Windows XP. Limited functionality is supported on Mac OS 
where customers can request for assistance via web-requests.

Windows XP and Internet Explorer 8 Update

Microsoft has ended support for Windows XP and IE8. Dell SonicWALL SRA clients will still 
continue to work, but may become more vulnerable to security risks and viruses. Dell 
SonicWALL will no longer provide fixes for issues exclusively affecting Windows XP and IE8. 
Dell SonicWALL strongly encourages Windows users to migrate to versions supported by 
Microsoft. For more information, refer to the Microsoft Windows website: 
http://windows.microsoft.com/en-us/windows/end-support-help

Web Management Interface Overview
From your workstation at your remote location, launch an approved Web browser and browse 
to your SRA appliance at the URL provided to you by your network Administrator.

Step 1 Open a Web browser and enter https://192.168.200.1 (the default LAN management IP 
address) in the Location or Address field. 

Step 2 A security warning may appear. Click the Yes button to continue.

Citrix (Java 1.6.0_10+)

Virtual Assist 
(Java not required)

Browser 
Independent 
(Java 
1.6.0_10+)

Browser 
Independent 
(Java 
1.6.0_10+)

Application Proxy

Features & Browser 
Requirements

Windows 
Vista

Windows 
7 

Windows 8 
/ 8.1 Linux MacOS X
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Step 3 The SonicWALL SSL VPN Management Interface displays and prompts you to enter your 
user name and password. As a default value, enter admin in the User Name field, password 
in the Password field, and select a domain from the Domain drop-down list and click the Login 
button. Only LocalDomain allows Administrator privileges. Note that your Administrator may 
have set up another login and password for you that has only user privileges.

The default page displayed is the Virtual Office home page. The default version of this page 
shows a SonicWALL logo, although your company’s system Administrator may have 
customized this page to contain a logo and look and feel of your company. Go to the Virtual 
Office Overview, page 9 to learn more about the Virtual Office home page.

From the Virtual Office portal home page, you cannot navigate to the Administrator’s 
environment. If you have Administrator’s privileges and want to enter the Administrator 
environment, you need to go back to the login page and enter a username and password that 
have Administrator privileges, and login again using the LocalDomain domain. Only the 
LocalDomain allows Administrator access to the management interface. Also note that the 
domain is independent of the privileges set up for the user.
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Logging in as a user takes you directly to Virtual Office. The Virtual Office Home page displays 
as shown here.

The Virtual Office content will vary based on the configuration of your network Administrator. 
Some bookmarks and services described in the SonicWALL SSL VPN User Guide may not be 
displayed when you log into the SonicWALL SRA security appliance.

The Virtual Office consists of the nodes described in the following table. 

Node Description
File Shares Provides access to the File Shares utility, which gives remote users with 

a secure Web interface access to Microsoft File Shares using the CIFS 
(Common Internet File System) or SMB (Server Message Block) proto-
cols. Using a Web interface similar in style to Microsoft’s familiar Net-
work Neighborhood or My Network Places, File Shares allow users with 
appropriate permissions to browse network shares, rename, delete, 
retrieve, and upload files, and to create bookmarks for later recall.

NetExtender Provides access to the NetExtender utility, a transparent SSL VPN cli-
ent for Windows, MacOS, Linux, Windows Mobile, or Android smart-
phone users that allows you to run any application securely on the 
remote network. It acts as an IP-level mechanism provided by the vir-
tual interface that negotiates the ActiveX component (on Windows with 
IE), using a Point-to-Point Protocol (PPP) adapter instance. On non-
Windows platforms except Android, Java controls are used to automati-
cally install NetExtender from the Virtual Office portal. After installation, 
NetExtender automatically launches and connects a virtual adapter for 
SSL secure NetExtender point-to-point access to permitted hosts and 
subnets on the internal network.

Secure Virtual Assist Provides access to Virtual Assist, an easy to use tool that allows Sonic-
WALL SSL VPN users to remotely support customers by taking control 
of their computers while the customer observes. Virtual Assist is a light-
weight, thin client that installs automatically using Java from the Sonic-
WALL SSL VPN Virtual Office without requiring the installation of any 
external software. For computers that do not support Java, Virtual 
Assist can be manually installed by downloading an executable file from 
the Virtual Office.
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The Home page provides customized content and links to network resources. The Home Page 
may contain support contact information, VPN instructions, company news, or technical 
updates. 

Only a Web browser is required to access intranet Web sites, File Shares, and FTP sites. VNC, 
Telnet and SSHv1 require Java. SSHv2 provides stronger encryption than SSHv1, requires 
SUN JRE 1.4 or above and can only connect to servers that support SSHv2. Terminal Services 
requires either Java or ActiveX on the client machine. 

As examples of tasks you can perform and environments you can reach through Virtual Office, 
you can connect to: 

• Intranet Web or HTTPS sites – If your organization supports Web-based email, such as 
Outlook Web Access, you can also access Web-based email

• The entire network by launching the NetExtender client

• FTP servers for uploading and downloading files

• The corporate network neighborhood for file sharing

• Telnet and SSH servers 

• Desktops and desktop applications using Terminal Services or VNC.

• Email servers via the NetExtender client.

The Administrator determines what resources are available to users from the SonicWALL SSL 
VPN Virtual Office. The Administrator can create user, group, and global policies that disable 
access to certain machines or applications on the corporate network. 

The Administrator may also define bookmarks, or preconfigured links, to Web sites or 
computers on the intranet. Additional bookmarks may be defined by the end user.

SonicWALL NetExtender is a software application that enables remote users to securely 
connect to the remote network. With NetExtender, remote users can virtually join the remote 
network. Users can mount network drives, upload and download files, and access resources in 
the same way as if they were on the local network.

Secure Virtual Meeting Provides access to Virtual Meeting, which allows multiple users to view 
a desktop and interactively participate in a meeting from virtually any-
where with an Internet connection. Virtual Meeting is similar to the one-
to-one desktop sharing provided by Virtual Assist except multiple users 
can share a desktop.

Secure Virtual Access (if config-
ured by Administrator

Secure Virtual Access allows Technicians to gain access to systems 
outside the LAN of the SRA appliance. After downloading and installing 
the thin client for Secure Virtual Access mode, the system will appear 
only on that Technician’s Virtual Assist support queue, within the SRA’s 
management interface.

Bookmarks Provides a list of available bookmarks which are objects that enable 
you to connect to a location or application conveniently and quickly. 

Options Provides the option to change user password and use single sign-on, if 
enabled by the Administrator. 

Online Help Launches online help for Virtual Office.

Tips/Help Provides a short list of common questions and tips about the Virtual 
Office. 

Logout Logs you out of the Virtual Office environment.

Node Description
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Certificates

If the SRA appliance uses a self-signed SSL certificate for HTTPS authentication, then it is 
recommended to install the certificate before establishing a NetExtender connection. If you are 
unsure whether the certificate is self-signed or generated by a trusted root Certificate Authority, 
SonicWALL recommends that you import the certificate. The easiest way to import the 
certificate is to click the Import Certificate button at the bottom of the Virtual Office home page.

If the certificate is not issued by an authorized organization, a message is displayed warning 
users of the risk. A user can then view detailed information and choose to continue or end the 
connection.

Logging Out of the Virtual Office
To end your session, simply return to the Virtual Office home page from wherever you are within 
the portal and click the Logout button.

When using the Virtual Office with the admin username, the Logout button is not displayed. 
This is a security measure to ensure that Administrators log out of the administrative interface, 
and not the Virtual Office.
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Chapter 3

Using Virtual Office Features

This chapter provides details on how to use the features in the Dell SonicWALL SSL VPN user 
portal. This chapter contains the following sections:

• “Importing Certificates” section on page 17

• “Using Two-Factor Authentication” section on page 17

• “Using One-Time Passwords” section on page 21

Importing Certificates
If the SSL VPN gateway uses a self-signed SSL certificate for HTTPS authentication, then it is 
recommended to install the certificate before establishing a NetExtender connection. If you are 
unsure whether the certificate is self-signed or generated by a trusted root Certificate Authority, 
Dell SonicWALL recommends that you import the certificate. 

If using Internet Explorer, the easiest way to import the certificate is to click the Import 
Certificate button at the bottom of the Virtual Office home page. The following warning 
messages may be displayed:

Click Yes. The certificate will be imported.

    Note Certificates can only be imported through this method if you are using Internet 
Explorer. Certificates for other browsers such as Chrome or Firefox must be 
imported manually.

Using Two-Factor Authentication
The following sections describe how to log in to the SSL VPN Virtual Office portal using two-
factor authentication:

• User Prerequisites on page 18

• User Configuration Tasks on page 18
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User Prerequisites

Before you can log in using two-factor authentication, you must meet the following 
prerequisites:

• Your Administrator has created your user account.

• You have an account with a two-factor authentication server that conforms to the RFC 
standard. 

User Configuration Tasks

The following sections describe how users log in to the Dell SonicWALL SRA appliance using 
the two types of two-factor authentication:

• RSA Two-Factor User Authentication Process on page 18

• VASCO Two-Factor User Authentication Process on page 20

• Other RADIUS Server Two-Factor Authentication Process on page 21

RSA Two-Factor User Authentication Process

The following sections describe user tasks when using RSA two-factor authentication to log in 
to the Dell SonicWALL SSL VPN Virtual Office:

• Logging into the SSL VPN Virtual Office Using RSA Two-Factor Authentication on page 18

• Creating a New PIN on page 19

• Waiting for the Next Token Mode on page 20

Logging into the SSL VPN Virtual Office Using RSA Two-Factor Authentication

To log in to the Dell SonicWALL SSL VPN Virtual Office using RSA two-factor authentication, 
perform the following steps.

Step 1 Enter the IP address of the SRA appliance in your computers browser. The authentication 
window is displayed.

Step 2 Enter your username in the Username field.

Step 3 The first time you log in to the Virtual office, your entry in the password field depends on 
whether your system requires a PIN:
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– If you already have a PIN, enter the passcode in the Password field. The passcode is 
the user PIN and the SecurID token code. For example, if the user’s PIN is 8675 and 
the token code is 30966673, then the passcode is 867530966673.

– If a PIN is required, but you do not yet have a PIN, enter the SecurID token code in the 
Password field. You will be prompted to create a PIN.

– If the RSA server does not require a PIN, simply enter the SecurID token code. 

    Note Consult with your network Administrator to determine if your configuration requires 
a PIN.

Step 4 Select the appropriate Domain. If manually entering the Domain, it is case-sensitive.

Step 5 Click Login.

Creating a New PIN

The RSA Authentication Manager automatically determines when users are required to create 
a new PIN. will determines that user associated with a particular token requires a new PIN. The 
SRA appliance prompts the user to enter new PIN.

Enter the PIN in the New PIN field and again in the Confirm PIN field and click OK. The PIN 
must be between 4 and 8 characters long.

Step 6 The RSA Authentication Manager verifies that the new PIN is an acceptable PIN. If the PIN is 
accepted, the user is prompted to log in with the new passcode.
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Waiting for the Next Token Mode

If user authentication fails three consecutive times, the RSA server requires the user to 
generate and enter a new token. To complete authentication, the user is prompted to wait for 
the token to change and enter the next token.

VASCO Two-Factor User Authentication Process

The following sections describe user tasks when using RSA two-factor authentication:

• Logging into the SSL VPN Virtual Office Using VASCO Two-Factor Authentication on 
page 20

• Creating a New PIN on page 19

Logging into the SSL VPN Virtual Office Using VASCO Two-Factor Authentication

To log in to the Dell SonicWALL SSL VPN Virtual Office using VASCO two-factor authentication, 
perform the following steps:

Step 1 Enter the IP address of the SRA appliance in your computer’s browser. The authentication 
window is displayed.

Step 2 Enter your username in the Username field.

Step 3 Enter the passcode in the Password field. Your entry in the password field depends on whether 
your system requires a PIN:

– If you already have a PIN, enter the passcode in the Password field. The passcode is 
the user PIN and the VASCO Digipass token code. For example, if the user’s PIN is 
8675 and the token code is 30966673, then the passcode is 867530966673.

– If a PIN is required, but you do not yet have a PIN, enter the VASCO Digipass code in 
the Password field. You will be prompted to create a PIN.

– If the RSA server does not require a PIN, simply enter the VASCO Digipass code. 

    Note Consult with your network Administrator to determine if your configuration requires 
a PIN.

Step 4 Select the appropriate Domain. If manually entering the Domain, it is case-sensitive.

Step 5 Click Login.
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Other RADIUS Server Two-Factor Authentication Process

To log in to the Virtual Office using another type of RADIUS server for two-factor authentication, 
perform the following steps:

Step 1 Enter the IP address of the SRA appliance in your computers browser. The authentication 
window is displayed.

Step 2 Enter your username in the Username field.

Step 3 Enter your password in the Password field.

Step 4 Select the appropriate Domain. If manually entering the Domain, it is case-sensitive.

Step 5 Click Login.

Step 6 You will be prompted to enter additional information, the details of which will depend on the type 
of RADIUS server used. The example below shows an M.ID RADIUS server, which first prompts 
you to “Please enter the M.ID PIN.” Enter the PIN in the Challenge field and click OK.

Step 7 You will then be prompted to “Please enter the M.ID Passcode.” Enter the passcode received 
through email or text message in the Challenge field and click OK.

Using One-Time Passwords
The following sections describe how to use one-time passwords:

• User Prerequisites, page 22

• User Configuration Tasks, page 22

• Verifying User One-Time Password Configuration, page 23
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User Prerequisites

Users must have a user account enabled in the SSL VPN management interface. Only users 
enabled by the Administrator to use the One-Time Password feature will need to perform the 
following configuration tasks. The Administrator must enable a correct email address that is 
accessible by the user. Users cannot enable the One-Time Password feature and they must be 
able to access the SSL VPN Virtual Office portal.

User Configuration Tasks

To use the One-Time Password feature, perform the following steps:

Step 1 If you are not logged into the SSL VPN Virtual Office user interface, open a Web browser and 
type the Virtual Office interface URL in the Location or Address bar and press Enter. Type in 
your user name in the User Name field and your password in the Password field, then select 
the appropriate domain from the Domain drop-down menu. Click Login. 

Step 2 The prompt “A temporary password has been sent to user@email.com” will appear, displaying 
your pre-configured email account.

Step 3 Login to your email account to retrieve the one-time password.

Step 4 Type or paste the one-time password into the Password: field where prompted and click Login.

Step 5 You will be logged in to the Virtual Office.

    Note One-time passwords are immediately deleted after a successful login, and cannot 
be used again. Unused one-time passwords will expire according to each user’s 
timeout policy.

Configuring One-Time Passwords for SMS-Capable Phones

One-Time Passwords can be configured to be sent via email directly to SMS-capable phones. 
Contact your cell phone service provider for further information about enabling SMS.

Below is a list of SMS email formats for selected major carriers, where 4085551212 represents 
a 10-digit telephone number and area code.

    Note These SMS email formats are for reference only. These email formats are subject to 
change and may vary. You may need additional service or information from your 
provider before using SMS. Contact the SMS provider directly to verify these formats 
and for further information on SMS services, options, and capabilities.

• Verizon: 4085551212@vtext.com

• Sprint: 4085551212@messaging.sprintpcs.com

• AT&T: 4085551212@mobile.att.net
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• Cingular: 4085551212@mobile.mycingular.com

• T-Mobile: 4085551212@tmomail.net

• Nextel: 4085551212@messaging.nextel.com

• Virgin Mobile: 4085551212@vmobl.com

• Qwest: 4085551212@qwestmp.com

For a more complete list, see the Dell SonicWALL SSL VPN Administrator's Guide. 

Verifying User One-Time Password Configuration

If you are successfully logged in to Virtual Office, you have correctly used the One-Time 
Password feature.

If you cannot login using the One-Time Password feature, verify the following:

• Are you able to login to the Virtual Office without being prompted to check your email for a 
one-time password? You have not been enabled to use the One-Time Password feature. 
Contact your SSL VPN Administrator.

• Is your email address correct? If your email address has been entered incorrectly, contact 
your SSL VPN Administrator to correct it.

• Is there no email with a one-time password? Wait a few minutes and refresh your email 
inbox. Check your spam filter. If there is no email after several minutes, try to login again 
to generate a new one-time password.

• Have you accurately typed the one-time password in the correct field? Re-type or copy and 
paste the one-time password.
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Chapter 4

 Using NetExtender

This chapter explains how to configure and use Dell SonicWALL NetExtender and includes the 
following sections:

• User Prerequisites on page 25

• “User Configuration Tasks” section on page 27

• “Verifying NetExtender Operation from the System Tray” section on page 48

User Prerequisites
Prerequisites for Windows Clients:

Windows clients must meet the following prerequisites in order to use NetExtender:

• One of the following platforms:

– Windows 8.1
– Windows 8 
– Windows 7 Services Pack 1
– Windows Vista Service Pack 2 (32-bit & 64-bit)

• One of the following browsers:

– Internet Explorer 9.0 and higher
– Mozilla Firefox 16.0 and higher
– Google Chrome 22.0 and higher

• To initially install the NetExtender client, the user must be logged in to the PC with 
administrative privileges.

• Downloading and running scripted ActiveX files must be enabled on Internet Explorer.

• If the SSL VPN gateway uses a self-signed SSL certificate for HTTPS authentication, it is 
necessary to install the certificate before establishing a NetExtender connection. If you are 
unsure if the certificate is self-signed or generated by a trusted root Certificate Authority, 
Dell SonicWALL recommends that you import the certificate. The easiest way to import the 
certificate is to click the Import Certificate button on the Virtual Office home page.

    Note Import Certificate is available from the Virtual Office portal only when using Internet 
Explorer on Windows 2000.

Prerequisites for MacOS Clients:

MacOS clients meet the following prerequisites in order to use NetExtender:

• MacOS 10.7 and higher

• Java 1.7 and higher

• Intel Macs are supported.
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Prerequisites for Linux Clients:

Linux 32-bit or 64-bit clients are supported for NetExtender when running one of the following 
distributions (32-bit or 64-bit):

• Linux Fedora Core 20 or higher, Ubuntu 12.04, 13.10, or higher, or OpenSUSE 10.3 or 
higher

• Java 1.7 and higher is required for using the NetExtender GUI.

The NetExtender client has been known to work on other distributions as well, but these are not 
officially supported.

    Note Open source Java Virtual Machines (VMs) are not currently supported. If you do not 
have Java 1.5 or higher, you can use the command-line interface version of 
NetExtender.

Using Mobile Connect 
Mobile Connect serves the same function as NetExtender on Apple iOS devices and Android 
devices, as listed below.

Prerequisites for Apple iOS Clients

Mobile Connect is supported on Apple iPhone, iPad, and iPod Touch devices running Apple 
iOS:

• iPhone5S – running Apple iOS 7 or higher

• iPhone5 – running Apple iOS 7 or higher

• iPhone 4S – running Apple iOS 5 or higher

• iPhone 4 – running Apple iOS 4.2 or higher

• iPhone 3GS – running Apple iOS 4.2 or higher

• iPhone 3G – running Apple iOS 4.2 or higher

• iPad Air – running Apple iOS 4.2 or higher

• iPad Mini Retina Display – running Apple iOS 4.2 or higher

• iPad Mini – running Apple iOS 4.2 or higher

• iPad 4 – running Apple iOS 4.2 or higher

• iPad 3 – running Apple iOS 4.2 or higher

• iPad 3 – running Apple iOS 4.2 or higher

• iPad 2 – running Apple iOS 4.2 or higher

• iPad – running Apple iOS 4.2 or higher

• iPod Touch (2nd Generation or later) – running Apple iOS 4.2 or higher

Mobile Connect acts as a NetExtender client when connecting to the Dell SonicWALL SRA. For 
Mobile Connect access to succeed, the portal must be set to allow NetExtender connections 
and the user account and group must be authorized to use NetExtender.

Dell SonicWALL Mobile Connect is an app for iPhone and iPad that, like NetExtender, uses SSL 
VPN to enable secure, mobile connections to private networks protected by Dell SonicWALL 
security appliances. For information about installing and using Dell SonicWALL Mobile 
Connect, see the Dell SonicWALL Mobile Connect User Guide at:
http://www.sonicwall.com/app/projects/file_downloader/document_lib.php?t=PG&id=482
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Mobile Connect is compatible with SRA and is a free download from iOS and Android (4.0+) 
app stores.

Prerequisites for Android Smartphone Clients

The NetExtender Android client is supported on rooted smartphones running the following 
versions of the Android operating system:

• 1.6 or higher

The NetExtender Android client is compatible with any Dell SonicWALL SSL VPN firmware 
version that supports the NetExtender Linux client, specifically:

• SSL VPN 4.0 and higher

As new features are added, users must install the updated client to access all the features 
supported by the new firmware. Likewise, if a new client is used with older firmware, some 
client features may not be functional. For best results, the latest firmware should always be 
used with the latest client.

    Note Only rooted devices are supported for NetExtender Android in Dell SonicWALL 
SRA.
The rooting requirement is due to limitations and restrictions of the Android platform. 
A layer 3 VPN client like NetExtender requires root permission for certain necessary 
OS level operations.

    Warning Rooting your phone may void your warranty. Consult your contract or User Guide, or call 

your service provider for more information.

Alternatively, the SonicWALL Mobile Connect client can be used for smartphones running 
Android version 4.0 or higher.

User Configuration Tasks
Dell SonicWALL NetExtender is a software application that enables remote users to securely 
connect to the remote network. With NetExtender, remote users can virtually join the remote 
network. Users can mount network drives, upload and download files, and access resources in 
the same way as if they were on the local network. 

The following sections describe how to use NetExtender on the various supported platforms:

Windows Platform Installation

• “Installing NetExtender Using the Mozilla Firefox Browser” section on page 28

• “Installing NetExtender Using the Internet Explorer Browser” section on page 31

Windows Platform Usage

• “Launching NetExtender Directly from Your Computer” section on page 36

• “Configuring NetExtender Properties” section on page 37

• “Configuring NetExtender Connection Scripts” section on page 39

• “Configuring Proxy Settings” section on page 41

• “Configuring NetExtender Log Properties” section on page 42
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• “Disconnecting NetExtender” section on page 46

• “Upgrading NetExtender” section on page 46

• “Authentication Methods” section on page 47

• “Verifying NetExtender Operation from the System Tray” section on page 48

• “Using the NetExtender Command Line Interface” section on page 49

MacOS Platform

• “Installing NetExtender on MacOS” section on page 50

• “Using NetExtender on MacOS” section on page 52

Linux Platform

• “Installing NetExtender on Linux” section on page 54

• “Using NetExtender on Linux” section on page 57

Windows Mobile Platform

• “Installing NetExtender on Android Smartphones” section on page 60

Android Smartphone Platform

• “Installing NetExtender on Android Smartphones” section on page 60

• “Using NetExtender on Android Smartphones” section on page 64

Installing NetExtender Using the Mozilla Firefox Browser

To use NetExtender for the first time using the Firefox browser, perform the following:

Step 1 To launch NetExtender, first log in to the SSL VPN portal.

Step 2 Click the NetExtender button.
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Step 3 The first time you launch NetExtender, it will automatically add an add-on to Firefox.

Step 4 Click the Install button. The portal will automatically install the NetExtender stand-alone 
application on your computer. If an older version of NetExtender is installed on the computer, 
the NetExtender launcher removes the old version and installs the new version.

Step 5 Once the NetExtender application is installed, a message appears instructing you to restart 
Firefox. Click the Restart Now button.
Using NetExtender | 29



Step 6 When Firefox restarts, the NetExtender Status window displays, indicating that NetExtender 
successfully connected.

The Status tab provides the following information:

Field Description

Server Indicates the name of the server to which the NetExtender 
client is connected.

Client IP Indicates the IP address assigned to the NetExtender client.

Sent Indicates the amount of traffic the NetExtender client has 
transmitted since initial connection.

Received Indicates the amount of traffic the NetExtender client has 
received since initial connection.

Throughput Indicates the current NetExtender throughput rate.
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Closing the window (clicking the x icon in the upper right corner of the window) does not close 
the NetExtender session, but minimizes it to the system tray for continued operation. Also, a 
balloon icon in the system tray appears, indicating NetExtender has successfully installed.

Step 7 The NetExtender icon  is displayed in the task bar.

Installing NetExtender Using the Internet Explorer Browser

Dell SonicWALL SSL VPN NetExtender is fully compatible with Microsoft Windows 7 32-bit and 
64-bit, and supports the same functionality as with other Windows operating systems. 
NetExtender is also compatible with the Mac OS X Lion 10.7.

   Note It may be necessary to restart your computer when installing NetExtender Windows 7. 

Internet Explorer Prerequisites

It is recommended that you add the URL or domain name of your SSL VPN server to Internet 
Explorer’s trusted sites list. This will simplify the process of installing NetExtender and logging 
in, by reducing the number of security warnings you will receive. To add a site to Internet 
Explorer’s trusted sites list, complete the following procedure:
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Step 1 In Internet Explorer, go to Tools > Internet Options.

Step 2 Click the Security tab.

Step 3 Click the Trusted Sites icon and click the Sites... button to open the Trusted sites window.

Step 4 Enter the URL or domain name of your SSL VPN server in the Add this Web site to the zone 
field and click Add.

Step 5 Click Ok in the Trusted Sites and Internet Options windows.

Installing NetExtender from Internet Explorer

To install and launch NetExtender for the first time using the Internet Explorer browser, perform 
the following:

Step 1 Log in to the SSL VPN Virtual Office portal.

Step 2 Click the NetExtender button.
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Step 3 A User Account Control window may appear asking “Do you want to allow this program to make 
changes to this computer?” Click Yes.

Step 4 The first time you launch NetExtender, you must first add the SSL VPN portal to your list of 
trusted sites. If you have not done so, the follow message will display.

Step 5 For details on how to add the Virtual Office as a trusted site, see the “Internet Explorer 
Prerequisites” section on page 31.

Step 6 Return to the SRA portal and click the NetExtender button. The portal automatically installs the 
NetExtender stand-alone application on the computer, and the NetExtender installer opens.
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If an older version of NetExtender is installed on the computer, the NetExtender launcher will 
remove the old version and then install the new version.

Step 7 When NetExtender completes installing, the NetExtender Status window displays, indicating 
that NetExtender successfully connected.

The information provided in the NetExtender Status window is described in the table on 
“Installing NetExtender Using the Mozilla Firefox Browser” on page 28.

Installing NetExtender Using the Chrome Browser

To install and launch NetExtender for the first time using the Chrome browser, perform the 
following:

Step 1 Log in to the SSL VPN Virtual Office portal.

Step 2 Click the NetExtender button.
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Step 3 Pull the NetExtender plug-in to Chrome Extensions.

Step 4 Return to the SSL VPN portal and click the NetExtender button. The portal will automatically 
install the NetExtender stand-alone application on your computer. The NetExtender installer 
window opens.

If an older version of NetExtender is installed on the computer, the NetExtender launcher will 
remove the old version and then install the new version.

Step 5 When NetExtender completes installing, the NetExtender Status window displays, indicating 
that NetExtender successfully connected.
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The information provided in the NetExtender Status window is described in the table on 
“Installing NetExtender Using the Mozilla Firefox Browser” on page 28.

Launching NetExtender Directly from Your Computer

After the first access and installation of NetExtender, you can launch NetExtender directly from 
your computer without first navigating to the SSL VPN portal. To launch NetExtender, complete 
the following procedure:

Step 1 Navigate to Start > All Programs.

Step 2 Select the Dell SonicWALL NetExtender folder, and then click SonicWALL NetExtender. The 
NetExtender login window is displayed.

Step 3 The IP address of the last SSL VPN server you connected to is displayed in the SSL VPN 
Server field. To display a list of recent SSL VPN servers you have connected to, click the arrow.

Step 4 Enter your username and password.

Step 5 The last domain you connected to is displayed in the Domain field.

    Note The NetExtender client will report an error message if the provided domain is invalid 
when you attempt to connect. Please keep in mind that domain names are case-
sensitive.

Step 6 The drop-down menu at the bottom of the window provides three options for remembering your 
username and password:

– Save user name & password if server allows

– Save user name only if server allows

– Always ask for user name & password

  Tip Having NetExtender save your user name and password can be a security risk and should 

not be enabled if there is a chance that other people could use your computer to access 

sensitive information on the network.
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Configuring NetExtender Properties

Complete the following procedure to configure NetExtender properties:

Step 1 Right click the icon  in the system tray and click Properties... The NetExtender Properties 
window is displayed.

Step 2 The Connection Profiles tab displays the SSL VPN connection profiles you have used, 
including the IP address of the SSL VPN server, the domain, and the username. 

Step 3 To create a shortcut on your desktop that will launch NetExtender with the specified profile, 
highlight the profile and click Create Shortcut.

Step 4 To delete a profile, highlight it by clicking on it and then click the Remove buttons. Click the 
Remove All buttons to delete all connection profiles.

Step 5 The Settings tab allows you to customize the behavior of NetExtender.
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Step 6 To have NetExtender launch when you log in to your computer, check the Automatically start 
NetExtender UI. NetExtender will start, but will only be displayed in the system tray. To have 
the NetExtender log-in window display, check the Display NetExtender UI check box.

Step 7 Select Minimize to the tray icon when NetExtender window is closed to have the 
NetExtender icon display in the system tray. If this option is not checked, you will only be able 
to access the NetExtender UI through Window’s program menu. 

Step 8 Select Display Connect/Disconnect Tips from the System Tray to have NetExtender display 
tips when you mouse over the NetExtender icon.

Step 9 Select Automatically reconnect when the connection is terminated to have NetExtender 
attempt to reconnect when it loses connection.

Step 10 Select Display precise number in connection status to display precise byte value 
information in the connection status.

Step 11 Select the Enable UI animations check box to enable the sliding animation effects in the UI.

Step 12 Select Uninstall NetExtender automatically to have NetExtender uninstall every time you end 
a session. 

Step 13 Select Disconnect an active connection to have NetExtender log out of all of your SSL VPN 
sessions when you exit a NetExtender session

Step 14 Click Apply.
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Configuring NetExtender Connection Scripts

Dell SonicWALL SSL VPN provides users with the ability to run batch file scripts when 
NetExtender connects and disconnects. The scripts can be used to map or disconnect network 
drives and printers, launch applications, or open files or Web sites. To configure NetExtender 
Connection Scripts, perform the following tasks.

Step 1 Right click the icon  in the task bar and click Properties... The NetExtender Preferences 
window is displayed.

Step 2 Click Connection Scripts.

Step 3 To enable the domain login script, select the Attempt to execute domain logon script check 
box. When enabled, NetExtender will attempt to contact the domain controller and execute the 
login script. Optionally, you may now also select to Hide the console window. If this check box 
is not selected, the DOS console window will remain open while the script runs.

    Note Enabling this feature may cause connection delays while remote client’s printers 
and drives are mapped. Make sure the domain controller and any machines in the 
logon script are accessible via NetExtender routes.

Step 4 To enable the script that runs when NetExtender connects, select the Automatically execute 
the batch file “NxConnect.bat” check box. Optionally, you may now also select to Hide the 
console window. If this check box is not selected, the DOS console window will remain open 
while the script runs.

Step 5 To enable the script that runs when NetExtender disconnects, select the Automatically 
execute the batch file “NxDisconnect.bat” check box.

Step 6 Click Apply.
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Configuring Batch File Commands

NetExtender Connection Scripts can support any valid batch file commands. For more 
information on batch files, see the following Wikipedia entry: http://en.wikipedia.org/wiki/.bat. 
The following tasks provide an introduction to some commonly used batch file commands. 

Step 1 To configure the script that runs when NetExtender connects, click the Edit “NxConnect.bat” 
button. The NxConnect.bat file is displayed.

Step 2 To configure the script that runs when NetExtender disconnects, click the Edit 
“NxDisconnect.bat” button. The NxConnect.bat file is displayed.

Step 3 By default, the NxConnect.bat file contains examples of commands that can be configured, but 
no actual commands. Too add commands, scroll to the bottom of the file.

Step 4 To map a network drive, enter a command in the following format: 

net use drive-letter\\server\share password /user:Domain\name

For example to if the drive letter is z, the server name is engineering, the share is docs, the 
password is 1234, the user’s domain is eng and the username is admin, the command would 
be the following:

net use z\\engineering\docs 1234 /user:eng\admin

Step 5 To disconnect a network drive, enter a command in the following format:

net use drive-letter: /delete

For example, to disconnect network drive z, enter the following command:

net use z: /delete

Step 6 To map a network printer, enter a command in the following format:

net use LPT1 \\ServerName\PrinterName /user:Domain\name

For example, if the server name is engineering, the printer name is color-print1, the domain 
name is eng, and the username is admin, the command would be the following:

net use LPT1 \\engineering\color-print1 /user:eng\admin

Step 7 To disconnect a network printer, enter a command in the following format:

net use LPT1 /delete

Step 8 To launch an application enter a command in the following format:

C:\Path-to-Application\Application.exe

Step 9 For example, to launch Microsoft Outlook, enter the following command:

C:\Program Files\Microsoft Office\OFFICE11\outlook.exe

Step 10 To open a Web site in your default browser, enter a command in the following format:

start http://www.website.com

Step 11 To open a file on your computer, enter a command in the following format:

C:\Path-to-file\myFile.doc

Step 12 When you have finished editing the scripts, save the file and close it.
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Configuring Proxy Settings

Dell SonicWALL SSL VPN supports NetExtender sessions using proxy configurations. 
Currently, only HTTPS proxy is supported. When launching NetExtender from the Web portal, 
if your browser is already configured for proxy access, NetExtender automatically inherits the 
proxy settings. 

To manually configure NetExtender proxy settings, perform the following tasks.

Step 1 Right click the icon  in the task bar and click Preferences... The NetExtender Preferences 
window is displayed.

Step 2 Click Proxy.

Step 3 Select the Enable proxy settings check box.

Step 4 NetExtender provides three options for configuring proxy settings:

– Automatically detect settings - To use this setting, the proxy server must support 
Web Proxy Auto Discovery Protocol (WPAD)), which can push the proxy settings script 
to the client automatically.

– Use automatic configuration script - If you know the location of the proxy settings 
script, select this option and enter the URL of the scrip in the Address field.

– Use proxy server - Select this option to enter the Address and Port of the proxy 
server. Optionally, you can enter an IP address or domain in the BypassProxy field to 
allow direct connections to those addresses that bypass the proxy server. If required, 
enter a User name and Password for the proxy server. If the proxy server requires a 
username and password, but you do not specify them in the Properties window, a 
NetExtender pop-up window will prompt you to enter them when you first connect.

Step 5 Click the Internet Explorer proxy settings button to open Internet Explorer’s proxy settings.
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Configuring NetExtender Log Properties

Within the NetExtender Properties dialog box, click the Log heading in the menu on the left 
panel. The available options provide basic control over the NetExtender Log and Debug Log.

Step 1 To establish the size of the NetExtender Log, select either the Unlimited log file size radio 
button or the Set maximum log file size to radio button. If you choose to set a maximum size, 
use the adjoining arrows. To clear the NetExtender Log, select the Clear NetExtender Log 
button.

Step 2 To Enable the NetExtender Debug Log, select the corresponding check box. To clear the 
debug log, select the Clear Debug Log button.

Step 3 Click the Log Viewer... button to view the current NetExtender log.

Step 4 Click Apply.
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Configuring NetExtender Advanced Properties

Within the NetExtender Properties dialog box, click the Advanced heading in the menu on the 
left panel. The available options allow you to adjust advanced settings on NetExtender network 
properties and protocols.
 

NetExtender allows users to customize the link speed that the NetExtender adapter reports to 
the operating system.

Step 1 To select a virtual link speed to report, select either the Report the underlying network speed 
to OS radio button, or select the Report a fixed speed radio button and designate a speed.

    Note Users can click the Advanced Network Properties button to make adjustments. 
However, modifying these settings may impact NetExtender performance and/or 
functionality. It is recommended to only make changes here if advised to do so by 
Dell SonicWALL support.
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Configuring NetExtender Packet Capture Properties

Within the NetExtender Properties dialog box, click the Packet Capture heading in the menu 
on the left panel. The available options allow you to enable and disable packet capture and data 
compression on NetExtender.
 

    Note You must have Administrator privileges to change packet capture settings.

Step 1 To enable packet capture, check the Enable NetExtender packet capture check box.

Step 2 If packet capture is enabled, clear all captured packet data when NetExtender exits by checking 
the Clear the capture when NetExtender exits check box. To disable packet capture, uncheck 
this check box.

Step 3 If packet capture is enabled, clear all captured packet data when NetExtender exits by checking 
the Clear the capture when NetExtender exits check box. To retain packet data, uncheck this 
check box.

Step 4 To enable data compression of captured packets, check the Enable data compression check 
box. To disable data compression the next time NetExtender is connected, uncheck this box. If 
packet capture is enabled when NetExtender connects and you want to disable data 
compression immediately (instead of waiting until the next time NetExtender is connected), 
check the Attempt to disable data compression during packet capture check box. 

Step 5 Click Apply to save your changes.
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Viewing the NetExtender Log

The NetExtender log displays information on NetExtender session events. The log is a file 
named NetExtender.dbg. It is stored in the directory: C:\Program Files\SonicWALL\SSL 
VPN\NetExtender. To view the NetExtender log, right click the NetExtender icon in the system 
tray, and click View Log, click the Log icon on the main status page. 

To view details of a log message, double-click a log entry, or go to View > Log Detail to open 
the Log Detail pane.

To save the log, either click the Export icon or go to Log > Export.

To filter the log to display entries from a specific duration of time, go to the Filter menu and 
select the cutoff threshold.

To filter the log by type of entry, go to Filter > Level and select one of the level categories. The 
available options are Fatal, Error, Warning, and Info, in descending order of severity. The log 
displays all entries that match or exceed the severity level. For example, when selecting the 
Error level, the log displays all Error and Fatal entries, but not Warning or Info entries.
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To view the Debug Log, either click the Debug Log icon or go to Log > Debug Log. 

    Note It may take several minutes for the Debug Log to load. During this time, the Log 
window will not be accessible, although you can open a new Log window while the 
Debug Log is loading.

To clear the log, click Log > Clear Log.

Disconnecting NetExtender

To disconnect NetExtender, perform the following steps:

Step 1 Right click the NetExtender icon in the system tray to display the NetExtender icon menu and 
click Disconnect.

Step 2 Wait several seconds. The NetExtender session disconnects.

You can also disconnect by double-clicking on the NetExtender icon to open the NetExtender 
window and then clicking the Disconnect button.

When NetExtender becomes disconnected, the NetExtender window displays and gives you 
the option to either Reconnect or Close NetExtender.

Upgrading NetExtender

NetExtender automatically notifies users when an updated version of NetExtender is available. 
Users are prompted to click OK and NetExtender downloads and installs the update from the 
Dell SonicWALL SRA security appliance.

When using releases prior to 2.5, users should periodically launch NetExtender from the Dell 
SonicWALL Virtual Office to ensure they have the latest version. Prior to release 2.5, the 
standalone NetExtender does not check for updates when it is launched directly from a user’s 
computer.

Changing Passwords

Before connecting to the new version of NetExtender, users may be required to reset their 
password by suppling their old password, along with providing and re-verifying a new one.
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Authentication Methods

NetExtender supports various two factor authentication methods, including one-time password, 
RSA, and Vasco. If an Administrator has configured one-time passwords to be required to 
connect through NetExtender, you will be asked to provide this information before connecting.

If an Administrator has configured RSA pin-mode authentication to be required to connect 
through NetExtender, users will be asked whether they want to create their own pin, or receive 
one that is system-generated.

Once the pin has been accepted, you must wait for the token to change before logging in to 
NetExtender with the new passcode.

During authentication, the SSL VPN server may be configured by the Administrator to request 
a client certificate. In this case, users must select a client certificate to use when connecting.
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Uninstalling NetExtender

The NetExtender utility is automatically installed on your computer. To remove NetExtender, 
click Start > All Programs, click Dell SonicWALL NetExtender, and then click Uninstall.

You can also configure NetExtender to automatically uninstall when your session is 
disconnected. To do so, perform the following steps:

Step 1 Right click the NetExtender icon  in the system tray and click Properties... The 
NetExtender Properties window is displayed.

Step 2 Click the Settings tab.

Step 3 Select Uninstall NetExtender automatically to have NetExtender uninstall every time you end 
a session.

Step 4 Click Apply. 

Verifying NetExtender Operation from the System Tray

To view options in the NetExtender system tray, right click the NetExtender icon in the system 
tray. The following are some tasks you can perform with the system tray.

Displaying Route Information

To display the routes that NetExtender has installed on your system, click the Route 
Information option in the system tray menu. The system tray menu displays the default route 
and the associated subnet mask.

Displaying Connection Information

You can display connection information by mousing over the NetExtender icon in the system 
tray.
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Using the NetExtender Command Line Interface 

    Note The NetExtender command line interface is only available on Windows platforms.

To launch the NetExtender CLI, perform the following tasks:

Step 1 Launch the Windows Command Prompt by going to the Start menu, select Run, enter cmd, 
and click OK.

Step 2 Change directory to where NetExtender is installed. To do this, you first must move up to the 
root drive by entering the cd .. command. Repeat this command until you are at the root drive. 
Then enter cd Program Files\SonicWALL\SSL-VPN\NetExtender. 

    Note The specific command directory may be different on your computer. Use Windows 
Explorer to find the directory path where NetExtender is located.

The following table describes the commands available in the NetExtender CLI and their options.

Table 1 NetExtender CLI Commands

Command Option Description
NECLI addprofile Creates a NetExtender profile

-s server The IP address or hostname of the SSL VPN 
server.

-u user-name The username for the account.

-p password The password for the account.

-d domain-name The domain to connect to.

NECLI connect Initiates a NetExtender session.

-s server The IP address or hostname of the SSL VPN 
server.

-u user-name The username for the account.

-p password The password for the account.

-d domain-name The domain to connect to.

- clientcertificatethumb 
thumb 

The SSL Client Certificate thumbprint value. 

- clientcertificatename 
name

The SSL Client Certificate name. 

NECLI deleteprofile Deletes a saved NetExtender profile.

-s server The IP address or hostname of the SSL VPN 
server.

-u user-name The username for the account.

-d domain-name The domain to connect to.

NECLI disconnect Disconnects

timeout (Optional) Timeout duration, after which the session 
is disconnected.
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Installing NetExtender on MacOS

Dell SonicWALL SSL VPN supports NetExtender on MacOS. To use NetExtender on your 
MacOS system, your system must meet the following prerequisites:

• Mac OS 10.6 and higher

• Java 1.5 and higher

• Both PowerPC and Intel Macs are supported.

To install NetExtender on your MacOS system, perform the following tasks:

NECLI displayprofile Displays all NetExtender profiles.

-s server (Optional) Displays only the profiles that are saved 
for the specified server.

-u user-name (Optional) Displays only the profiles that are saved 
for the specified user name.

-d domain-name (Optional) Displays only the profiles that are saved 
for the specified domain name.

NECLI queryproxy Checks the connect to the proxy server.

NECLI reconnect Attempts to reconnect to the server.

NECLI showstatus Displays the status of the current NetExtender ses-
sion.

NECLI setproxy Configures proxy settings for NetExtender.

-t [0 |1 | 2 | 3] There are three options for setting proxy settings:
0 - Disable proxy.
1 - Automatically detects proxy settings. The proxy 
server must support Web Proxy Auto Discovery 
Protocol (WPAD).
2 - Uses a proxy configuration script.
3 - Manually configure the proxy server.

-s proxy address The address of the proxy script or proxy server.

-o port The port number.

-u user name The user name for the proxy server.

-p password The password name for the proxy server.

-b bypass-proxy Bypasses the previously configured proxy settings.

-save Saves the proxy settings.

NECLI viewlog Displays the NetExtender log.

Table 1 NetExtender CLI Commands

Command Option Description
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Step 1 Log in to the Dell SonicWALL Virtual Office.

Step 2 Click the NetExtender button.

Step 3 The Virtual Office displays the status of NetExtender installation. A pop-up window may appear, 
prompting you to accept a certificate. Click Trust.

Step 4 A second pop-up window may appear, prompting you to accept a certificate. Click Trust.

Step 5 When NetExtender is successfully installed and connected, the NetExtender status window 
displays.
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Using NetExtender on MacOS

Step 1 To launch NetExtender, go the Applications folder in the Finder and double-click 
NetExtender.app.

Step 2 The first time you connect, you must enter the Dell SonicWALL SSL VPN server name in the 
SSL VPN Server field. 

Step 3 Enter your username and password.

Step 4 The first time you connect, you must enter the domain name. The domain name is case-
sensitive.

Step 5 Click Connect.

Step 6 You can instruct NetExtender remember your profile server name in the future. In the Save 
profile drop-down menu you can select Save name and password (if allowed), Save 
username only (if allowed), or Do not save profile.

Step 7 When NetExtender is connected, the NetExtender icon is displayed in the status bar at the top 
right of your display. Click the icon to display NetExtender options.
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Step 8 To display a summary of your NetExtender session, click Connection Status.

Step 9 To view the routes that NetExtender has installed, select the Routes tab in the main 
NetExtender window.

Step 10 To view the NetExtender Log, go to Window > Log.

Step 11 To generate a diagnostic report with detailed information on NetExtender performance, go to 
Help > Generate diagnostic report.
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Step 12 Click Save to save the diagnostic report using the default nxdiag.txt file name in your 
NetExtender directory.

Installing NetExtender on Linux

Dell SonicWALL SSL VPN supports NetExtender on Linux. To use NetExtender on your Linux 
system, your system must meet the following prerequisites:

• i386-compatible distribution of Linux

• Linux Fedora Core 15 or higher, Ubuntu 11.10 or higher, or OpenSUSE 10.3 or higher

• Java 1.5 and higher is required for using the NetExtender GUI.

    Note Open source Java Virtual Machines (VMs) are not currently supported. If you do not 
have Java 1.5, you can use the command-line interface version of NetExtender.

To install NetExtender on your Linux system, perform the following tasks:
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Step 1 Log in to the Dell SonicWALL Virtual Office.

Step 2 Click the NetExtender button. A pop-up window indicates that you have chosen to open a .tgz 
file. Click OK to save it to your default download directory.
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    Note You must be logged in as root to install NetExtender, although many Linux systems 
will allow the sudo ./install command to be used if you are not logged in as root.

Step 3 To install NetExtender from the CLI, navigate to the directory where you saved the .tgz file and 
enter the tar -zxf NetExtender.tgz command.

Step 4 Enter the cd netExtenderClient/ command.

Step 5 Enter su -C “ ./install” to install NetExtender.

Step 6 Enter your system password.

Step 7 The installer will ask if you want non-root users to be able to run NetExtender. Enter either y for 
yes or n for no.
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    Note To allow non-root users to run NetExtender, the installer will set PPPD to run as root. 
This may be considered a security risk. 

Using NetExtender on Linux

To use NetExtender on a Linux computer, perform the following tasks:

Step 1 After NetExtender is installed, there are two methods to launch it:

– Click the NetExtender icon in the Applications menu, under either the Internet or 
Network category.
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– Enter the netExtenderGui command.

Step 2 The first time you connect, you must enter the Dell SonicWALL SSL VPN server name in the 
SSL VPN Server field. NetExtender will remember the server name in the future.

Step 3 Enter your username and password.

Step 4 The first time you connect, you must enter the domain name. The domain name is case-
sensitive. NetExtender will remember the domain name in the future.

Step 5 To view the NetExtender routes, select the Routes tab in the main NetExtender window.

Step 6 To view the NetExtender DNS server information, select the DNS tab in the main NetExtender 
window.
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Step 7 To configure NetExtender Preferences, select NetExtender > Preferences. 

Step 8 The following NetExtender settings can be configured:

• Automatically reconnect when the connection is terminated

• Uninstall NetExtender automatically when exiting the application

• DNS server options:

– Try remote DNS servers first, then try local DNS servers

– Only use remote DNS servers

– Only use local DNS servers

Step 9 The Advanced tab of the NetExtender Preferences window provides two additional options:

• MTU - Sets the Maximum Transmission Unit (MTU) size, which is the largest packet size 
that a router can forward without needing to fragment the packet.
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• PPP Sync Mode - Specifies synchronous PPP. By default, this option is disabled and 
asynchronous PPP is used. 

Step 10 To view the NetExtender Log, go to NetExtender > Log.

Step 11 To generate a diagnostic report with detailed information on NetExtender performance, go to 
Help > Generate diagnostic report.

Step 12 Click Save to save the diagnostic report using the default nxdiag.txt file name in your 
NetExtender directory.

Installing NetExtender on Android Smartphones
Dell SonicWALL SSL VPN supports NetExtender on smartphones running the Android 
operating system. The NetExtender Android client supports the following features:

• One-time passwords

• Two-factor authentication

• HTTP/HTTPS proxy
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• Connection profiles

The NetExtender Android installer is available on MySonicWALL in the standard apk package 
format. The installer is also available from Play Store as the NetExtender Technology Preview.

The following features are not supported or not applicable on NetExtender Android in Dell 
SonicWALL SSL VPN:

• Automatic connection of NetExtender before Windows login

• Automatic proxy support and Internet Explorer proxy synchronization

• Connection scripts

• IPv6 support

• Client certificate support

• Exit client after disconnect

To install NetExtender on an Android smartphone using the apk package from MySonicWALL, 
perform the following tasks:

Step 1 On a computer, log in to http://mySonicWALL.com. 

Step 2 Click Downloads.

Step 3 In the Software Type drop-down menu, select one of the following:

• SRA 4200 Firmware

• SRA 1200 Firmware
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• SRA VM

Step 4 Click the NetExtender (Android) link.

Step 5 Save the .apk file onto your computer.

Step 6 Using the USB cable, connect your computer to the Android smartphone.

Step 7 On the Android smartphone, pull down the notifications.

Step 8 Tap USB connected to connect to the computer. The next screen shows the connection.

Step 9 Tap Turn on USB storage to prepare for copying the apk installer to the Android smartphone.
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Step 10 On the computer, copy the apk file to the Android SD card.

Step 11 Unmount the Android SD card from your computer. On Windows, it will show up under “My 
Computer” as a new drive. On Mac, a new drive will show up on the desktop.

Step 12 After unmounting the Android SD card from your computer, tap Turn off USB storage.

Step 13 On your Android smartphone, launch a file browser application. 

Step 14 Using the file browser, locate the apk file and run it to install NetExtender Android. After 
installation, the NetExtender icon appears on the applications page of the smartphone.
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Using NetExtender on Android Smartphones
Instructions for using NetExtender on your Android smartphone are available in the following 
sections:

• “Connecting to NetExtender” on page 65

• “Exiting or Disconnecting from NetExtender” on page 69

• “Checking Status, Routes, and DNS Settings” on page 71

• “Configuring Profiles, Preferences, and Proxy Servers” on page 72

• “Changing Your Password” on page 77
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Connecting to NetExtender

To launch NetExtender on your Android smartphone and connect to the network through the 
Dell SonicWALL SRA appliance, perform the following steps:

Step 1 On your Android smartphone, start NetExtender by tapping the application icon. The 
NetExtender connection options screen displays. Enter the information into the Server, User, 
Password, and Domain fields.

Step 2 Tap Connect to accept the default option (Save user name & password) or select a Save... 
or Always ask... option from the drop-down list. The available profile options depend on how 
NetExtender is configured on the Dell SonicWALL appliance. 

Step 3 The smartphone displays the Login - Initializing engine screen. 
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After a successful connection, the entered values are saved as a profile that you can select 
when starting NetExtender. NetExtender saves the information in a secure file on the 
smartphone.

Step 4 If One Time Password is enabled on the Dell SonicWALL SRA appliance, the One Time 
Password prompt is displayed. Enter the temporary password that was emailed to your 
configured account, and tap OK.

If your smartphone is synchronized to your email account, you can pull down the email 
notification from the top bar, or switch to your home page and access your email from there. 
After viewing the temporary password in your email or copying it to your clipboard, tap the 
NetExtender application icon to return directly to this screen.

To use the clipboard, press the password in your email and select Select Text. Press the 
selected text again and select Copy. Then in the OTP screen, press the field and select Paste. 
Some Android smartphones require you to hold the OK button for clipboard access.

Step 5 If Two Factor Authentication is enabled on the Dell SonicWALL SRA appliance, you may be 
prompted to update your PIN (Personal Identification Number) or create a new one.
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If no PIN has yet been configured, or if the Administrator has reset the account, the following 
screen asks if the system should generate a new PIN. To allow the system to generate it, tap 
Yes. To type in a PIN yourself, tap No and skip to Step 7.

Step 6 If you chose to allow the system to generate the PIN, the display then prompts you to accept 
the generated PIN. Tap Yes to accept it, or tap No to have the system generate a different PIN. 
You are prompted each time until you tap Yes.

Step 7 If you chose to generate the PIN yourself, type a PIN into the PIN field and again in the second 
field to confirm it. Typically, PINs are required to be 4 to 8 digits. Tap OK.
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Step 8 After entering the PIN or creating a new PIN, the Two Factor Authentication process requires 
you to enter the token code shown on your token device. Wait for the token code to change on 
the device, and then type the code into the field on your smartphone and tap OK.

Step 9 If a proxy server is configured in the smartphone (via Preferences), the Proxy Authentication 
screen is displayed next. Enter the username and password for the proxy and tap OK.

Step 10 NetExtender will connect at this point, unless there is a problem or error. You will see the 
NetExtender traffic indicator appear in the notification bar at the top of the display, unless it is 
disabled in Preferences.

The up and down arrows appear white when data is passing through the VPN tunnel. When no 
data is currently passing, the arrows appear gray. Control traffic does not affect the arrow 
colors. 
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The up arrow indicates that data is being sent from the smartphone to the network, and the 
down arrow indicates that data is being received from the network by the smartphone.

Step 11 If the NetExtender service running on the smartphone has a problem or has stopped running, 
the following screen is displayed. Tap Exit to quit the application. You may need to restart the 
service, possibly by turning the phone off and on again, or you may need to re-install 
NetExtender.

Exiting or Disconnecting from NetExtender

EXIT

Exiting and restarting NetExtender is useful when NetExtender cannot connect, possibly after 
a long period of disuse. To exit from NetExtender, perform the following steps:

Step 1 To access the Exit option, press the options or menu button while on the NetExtender screen. 
The options are displayed at the bottom of the screen.

Step 2 To cause NetExtender to exit completely, including the services component, select the Exit 
option and tap OK. You can restart NetExtender by clicking its icon on your smartphone. 

DISCONNECT

To disconnect NetExtender, perform the following steps:
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Step 1 Pull down the notification bar and click NetExtender to open the NetExtender user interface.

Step 2 In the NetExtender user interface, tap the Disconnect button and tap OK to confirm.

NetExtender notifies you while disconnecting.
70 | SRA 7.5 User Guide



Checking Status, Routes, and DNS Settings

While NetExtender is connected, you can view status information, routes, and DNS settings on 
your smartphone.

Step 1 To open the NetExtender user interface, pull down the notification bar and tap NetExtender.

Step 2 To view status information, tap the Status tab. You can tap on the Sent, Received, or 
Throughput fields to change the units between bytes and packets.
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If you are connected to a Dell SonicWALL SRA appliance running 5.0 or higher, and you have 
an Active Directory account, the User field contains your display name, such as 
“Sonia Eng”. If you are connected to an appliance running the 4.0 release or you do not have 
an Active Directory account, the User field displays the login name, such as “seng”.

Step 3 To view NetExtender routes, tap the Routes tab. The display shows all subnets currently 
available from the smartphone.

Step 4 To view the configured DNS servers, tap the DNS tab.

NetExtender Android supports DNS only; WINS or DNS suffix are not supported. 

Configuring Profiles, Preferences, and Proxy Servers

To configure NetExtender profiles and preferences, including proxy servers, on your Android 
smartphone, perform the following steps:

Step 1 To display NetExtender options, start NetExtender and then press the options or menu button 
on the smartphone. The options are displayed at the bottom of the screen.
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PROFILES

Step 2 To display the NetExtender Profiles screen, start NetExtender and then press the options or 
menu button on the smartphone and tap Profiles.

Step 3 To display the Remove selected, Remove all, and Close options on this NetExtender 
Profiles screen, press the options button while on the screen.

Step 4 Tap Remove selected to remove the profiles that have check marks next to them.

Step 5 Tap Remove all to remove all profiles from the smartphone.

Step 6 Tap Close to close the option display on this screen.

Step 7 To display the Remove this profile, Remove selected profiles, and Remove all profiles 
options, press and hold the NetExtender Profiles screen.
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Step 8 Tap Remove this profile to remove the profile that you pressed on to bring up this screen.

Step 9 Tap Remove selected to remove the profiles that have check marks next to them.

Step 10 Tap Remove all to remove all profiles from the smartphone.

Step 11 Tap Close to close the option display on this screen.

EXPORT LOG

Step 12 To export the log file of NetExtender Android activity, select the Export Log option and enter 
the requested information.

ABOUT

Step 13 To view NetExtender version information, select the About option.
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PREFERENCES / PROXY SETTINGS

Step 14 To configure NetExtender preferences including proxy and notification settings, select the 
Preferences option.

Step 15 Under General settings, select the Connection notification check box to display the 
NetExtender traffic indicator  in the notification bar.

Clear the check box to prevent the indicator from being displayed.

Step 16 Under Proxy, select the Use Proxy check box to configure NetExtender Android to access 
external networks through a proxy server. 

A proxy server is often used for access to the Internet if the initial connection is made to a local 
zone, such as LAN or WLAN.

Step 17 After selecting the Use Proxy check box, tap Proxy settings to open the configuration screen 
for the proxy server. 

Step 18 Type the IP address of the proxy server into the Server field. Type the port number of the port 
that the server listens on into the Port field. This field displays “8080” by default, but there is 
no standard listening port for a proxy server.

Step 19 Optionally enter your login credentials for the server in the User and Password fields. Entering 
your credentials here causes NetExtender to save them, so that you can automatically connect 
to the proxy server during subsequent logins without being prompted for credentials.
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NetExtender Android supports basic authentication using a username and password for proxy 
servers. Microsoft NTLM authentication is not currently supported.

Step 20 When finished configuring the proxy server settings, tap OK.
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Changing Your Password

To change your password when prompted by NetExtender, perform the following steps:

Step 1 After connecting, a password expiration notice may be displayed on your Android smartphone. 
Tap Yes to change your password, or No to delay until a later time. NetExtender will remind you 
each time you connect.

Step 2 If you select Yes, the Change password screen is displayed. Type your password into the 
Current Password field, then type a new password into the New password field and again into 
the Type it again field. Tap OK.

Step 3 If your password expires before you change it, the Change password screen is displayed when 
you connect, with the message “Login failed – you must change your password.” 
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Type your old password into the Current Password field, then type a new password into the 
New password field and again into the Type it again field. Tap OK.

Related Documents
The following Technical Notes provide more information on advanced NetExtender scenarios:

• Running NetExtender on a Different TCP Port:
http://www.sonicwall.com/us/support/2134_3154.html

• Using the Dell SonicWALL CDP Agent over a Dell SonicWALL NetExtender Connection
http://www.sonicwall.com/us/support/2134_3487.html

• Using Dell SonicWALL NetExtender to Access FTP Servers
http://www.sonicwall.com/us/support/2134_3465.html

• Resolving NetExtender Error With McAfee Enterprise 8.5
http://www.sonicwall.com/us/support/2134_6813.html
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Chapter 5

Using Secure Virtual Assist

Secure Virtual Assist provides remote assistance and virtual meeting capabilities. Secure 
Virtual Assist is an easy to use tool that allows Dell SonicWALL SSL VPN users to remotely 
support customers by taking control of their computers while the customer observes. Secure 
Virtual Meeting allows Dell SonicWALL SSL VPN users to participate in virtual meetings via the 
internet.

Secure Virtual Assist is a lightweight, thin client that installs automatically using the Dell 
SonicWALL SSL VPN Virtual Office. Secure Virtual Assist can also be installed as a stand-
alone client that can be launched directly from the client’s computer.

The following sections describe how to use Secure Virtual Assist and Secure Virtual Meeting:

• “Using Secure Virtual Assist” section on page 79

• “Using Secure Virtual Meeting” section on page 111

Using Secure Virtual Assist
The following sections describe how to use Secure Virtual Assist:

• “Installing and Launching Secure Virtual Assist” section on page 80

• “Configuring Secure Virtual Assist Settings” section on page 81

• “Selecting a Secure Virtual Assist Mode” section on page 84

• “Launching a Secure Virtual Assist Technician Session” section on page 85

• “Performing Secure Virtual Assist Technician Tasks” section on page 86

• “Initiating a Secure Virtual Assist Session from the Customer View” section on page 93

• “Using Secure Virtual Assist” section on page 104

• “Using Secure Virtual Assist in Unattended Mode” section on page 106

• “Enabling a System for Secure Virtual Access” section on page 106

• “Using the Request Assistance Feature” section on page 110

Secure Virtual Assist is fully supported on Windows platforms. Secure Virtual Assist is certified 
to work on Windows 8, Windows 7, Windows Vista and Windows XP. The Secure Virtual Assist 
client is also available for Linux and Mac OS.

    Note When a user requests service as a customer, Virtual Assist can be run while 
connected to the system over an RDP session for Windows 7 and Windows Vista 
platforms; however, Virtual Assist over RDP will have a limited set of features.

There are two sides to a Virtual Assist session: the customer view and the Technician view. The 
customer is the person requesting assistance on their computer. The Technician is the person 
providing assistance. A Virtual Assist session consists of the following sequence of events:

1. The Technician launches Virtual Assist from the Dell SonicWALL SSL VPN Virtual Office. 

2. The Technician monitors the Assistance Queue for customers requesting assistance.

3. The customer requests assistance by one of these methods:
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– Logs into the Dell SonicWALL SSL VPN Virtual Office and clicks on the Request 
Assistance link.

– Receives an email invitation from the Technician and clicks on the link to launch Virtual 
Assist.

– Navigate directly to the URL of the Virtual Assist home page that is provided by the 
Technician.

– If the Virtual Assist client is already installed, launch the client and click the Request 
Assistance option. 

4. The Secure Virtual Assist application installs and runs on the customer’s system.

5. The customer appears in the Virtual Assist Assistance Queue.

6. The Technician clicks on the customers name and launches a Virtual Assist session.

7. The Technician’s Virtual Assist window now displays the customers entire display. The 
Technician has complete control of the customer computer’s mouse and keyboard. The 
customer sees all of the actions that the Technician performs.

8. If at anytime the customer wants to end the session, they can take control and click the End 
Virtual Assist button in the bottom right corner of the screen.

9. When the session ends, the customer resumes sole control of the computer.

Installing and Launching Secure Virtual Assist

To install and launch a Virtual Assist session, perform the following steps.

Step 1 Log in to the Dell SonicWALL SRA security appliance Virtual Office. If you are already logged 
in to the Dell SonicWALL SSL VPN customer interface, click the Virtual Office button.

Step 2 Click the Request Assistance button.

Step 3 The first time you launch Virtual Assist, you will be prompted to install the Secure Virtual Assist 
plugin and client.

Step 4 Click the Allow button. A plugin installation window displays. Click Install Now. The Secure 
Virtual Assist plugin and client installs. You may be prompted to restart your browser.

Step 5 You can now launch Virtual Assist either from the Virtual Office window or from a shortcut that 
is added to your Programs list under Window’s start button.
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Configuring Secure Virtual Assist Settings

The Secure Virtual Assist Settings window can be accessed either by clicking the Settings 
button in the top left corner of the application window or by right-clicking on the Virtual Assist 
icon in the taskbar and selecting Settings. The Virtual Assist Settings window has three tabs, 
as shown in the following figures. The content of these tabs and configuration vary depending 
on whether Secure Virtual Assist is being configured on a Windows or MacOS device.

Windows Configuration

To configure Secure Virtual Assist for Windows:

• Proxy Settings - Allows users to configure a Proxy server to access the SRA appliance. 
There are three options for configuring proxy settings.

– Automatically detect settings - To use this setting, the proxy server must support 
Web Proxy Auto Discovery Protocol (WPAD)), which can push the proxy settings script 
to the client automatically.

– Use automatic configuration script - If you know the location of the proxy settings 
script, select this option and enter the URL of the scrip in the Address field.

– Use proxy server - Select this option to enter the Address and Port of the proxy 
server. Optionally, you can enter an IP address or domain in the BypassProxy field to 
allow direct connections to those addresses that bypass the proxy server. If required, 
enter a User name and Password for the proxy server. If the proxy server requires a 
username and password, but you do not specify them in the Properties window, a 
NetExtender pop-up window will prompt you to enter them when you first connect.

– Optionally, you can click the Internet Explorer proxy settings button to open Internet 
Explorer’s proxy settings page.
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• Connection Profiles - Displays all of the Virtual Assist connection profiles that have been 
used on this computer. To remove a profile, select it and click the Remove button.

• Connection Settings - Allows users to customize how they are identified in Virtual Assist 
and the default settings of Virtual Assist customer sessions.

– Display Name - The name that will be displayed in the user queue. By default, the 
users SSL VPN username is displayed. 

– Additional Information - Optional field to provide additional information.

– Auto View Only - Specifies that Virtual Assist sessions will initially launch in View-Only 
mode instead of Trusted mode, which is the default.

– Active Mode - Specifies that Virtual Assist sessions will initially launch in Active mode 
instead of Trusted mode, which is the default. 
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– Recorded Medial File Path - The default location where the recorded support sessions 
will be stored on the client PC.

MacOS Configuration

To configure Secure Virtual Assist for MacOS: 

• Proxy Settings - Either load proxy settings from the system configuration by clicking the 
Load System Proxy Settings button or manually configure the proxy server, port, 
bypassed proxy, user name, and password. 

• Connection Profiles - View and manage connection profiles in the Connection Profiles tab 
by clicking the Remove All button to remove all profiles or selecting the profile and clicking 
the Remove button. 
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10. Connection Settings - Create and edit connection profiles as follows: 

– Default Request Name - Type the support request name for the customer.

– Additional Request Information - Type the support request information for the 
customer.

– Connect Settings - Select either Auto View Only or Active Mode. When Auto View 
Only is enabled, any mouse or keyboard action while a technician is connected triggers 
the View Only mode. When Active Mode is enabled, users are in Active mode by 
default while a technician is connected.

– Color Scheme for View Only - Select Full Color or Gray Scale. When Full Color is 
selected and the user is in View Only mode, the technician view is in full color. When 
Gray Scale is selected, the view is grey monochrome. 

The MacOS Secure Virtual Assist windows and toolbar are very similar to the Windows version. 
Any significant differences are noted elsewhere in this document.

Selecting a Secure Virtual Assist Mode

When you first launch Secure Virtual Assist, by default it will be in customer mode. To change 
the mode, perform the following steps.
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Step 1 Click Change Mode to select one of four possible modes.

Step 2 Select one of the following four Virtual Assist modes:

• Customer - Select this mode to request support. For information on customer mode, see 
the “Initiating a Secure Virtual Assist Session from the Customer View” section on page 93.

• Unattended - Select this mode to receive support help while you are away from your 
computer. You will be prompted to enter a password, which the Technician can then enter 
and assume control of your system without further confirmation from you. For information 
on unattended mode, see the “Using Secure Virtual Assist in Unattended Mode” section on 
page 106.

• Technician - Select this mode to service customers by remotely controlling their systems. 
For information on Technician mode, see the “Launching a Secure Virtual Assist Technician 
Session” section on page 85.

• Virtual Access - Select this mode to make your computer remotely accessible at all times 
from the SSL VPN appliance. For information on Secure Virtual Access mode, see the 
“Enabling a System for Secure Virtual Access” section on page 106.

Step 3 Click Change Mode again to login with the selected mode.

Launching a Secure Virtual Assist Technician Session

To launch a Virtual Assist Technician session to remotely assist customers, perform the 
following steps.

Step 1 Launch Virtual Assist and select the Technician Mode.

Step 2 In the Server drop-down menu, select the IP address or domain name of the Dell SonicWALL 
SRA appliance.

Step 3 Enter the Username and Password for the Technician account on the appliance.

Step 4 Click Login.The Select Domain window displays.
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Step 5 Select the Domain that the username is configured for and click OK.

Step 6 The Secure Virtual Assist standalone application launches.

The Technician is now ready to assist customers.

Performing Secure Virtual Assist Technician Tasks

To get started, the Technician logs into the Dell SonicWALL SRA appliance and launches the 
Secure Virtual Assist application.

   Note Each Technician can only assist one customer at a time.

By default, the Virtual Assist window launches with the Virtual Assist toolbar at the top and the 
rest of the window dedicated to the customer’s screen.To display the most common panes, 
either click Expand or click View > Classic Layout. This will display the following panes:

• Email Invite

• Logging

• Chat
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• Service

Once the Technician has launched the Virtual Assist application, the Technician can assist 
customers by performing the following tasks:

• “Inviting Customers by Email” on page 87

• “Assisting Customers” on page 87

• “Using the Windows Virtual Assist Taskbar and Tab Controls” on page 88

• “Using the Secure Virtual Assist File Transfer” on page 92

• “Changing the Secure Virtual Assist Level of Control” on page 105

• “Ending a Virtual Assist Session” on page 105

• “Ending a Virtual Assist Session” on page 105

Inviting Customers by Email

Step 1 To invite a customer to Virtual Assist, use the email invitation form on the left of the Virtual 
Assist window. If it is not displayed, click the Invite button in the toolbar.

    Note Customers who launch Virtual Assist from an email invitation can only be assisted 
by the Technician who sent the invitation. Customers who manually launch Virtual 
Assist can be assisted by any Technician.

Step 2 Enter the customer’s email address in the Customer Email field.

Step 3 Optionally, enter Technician Email to use a different return email address than the default 
Technician email. Some mail servers require that an email address be entered, and that it be 
on a valid domain.

Step 4 Optionally, enter an Additional Message to the customer.

Step 5 Click Invite. The customer will receive an email with an HTML link to launch Virtual Assist.

Customers requesting assistance will appear in the Assistance Queue, and the duration of time 
they have been waiting will be displayed.

Assisting Customers

A pop-up window in the bottom right task bar alerts the Technician when a customer is in the 
assistance queue. The customer queue is also displayed in the Service window.

Step 1 Double-click a customer’s user name to begin assisting the customer. 
Using Secure Virtual Assist | 87



   Note Return a customer to the queue by right-clicking the user name on the Service List and 
selecting Requeue. Someone else in a Technician role can then service this user. This is 
useful if one Technician needs to hand off the user to another Technician, because of 
differing areas of expertise or the end of shift.

Step 2 The customer’s entire desktop is displayed in the bottom right window of the Secure Virtual 
Assist application.

The Technician now has complete control of the customer’s keyboard and mouse. The 
customer can see all of the actions that the Technician performs.

During a Virtual Assist session, the customer is not locked out of their computer. Both the 
Technician and customer can control the computer, although this may cause confusion and 
consternation if they both attempt “to drive” at the same time. 

The small tool bar in the bottom right of the screen provides options during a Virtual Assist 
session:

• Trusted/Active - Toggles to the View Only mode, where the Technician can view the 
customer’s computer but cannot control the computer. 

• Chat - Initiates a chat window with the Technician.

• End Virtual Assist - Terminates the session.

Using the Windows Virtual Assist Taskbar and Tab Controls

The Technician’s view of Virtual Assist includes a Taskbar with a number of options.

• Invite - Displays the Email Invite pane.

• Chat - Displays the chat window to communicate with the customer. 
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• Service - Displays the service queue of customers awaiting service.

• Logging - Displays the log window.

• Viewer - Displays or hides the entire Virtual Assist window.

• Options - Displays Connection Profile and Connection Settings options.

• Expand - Displays the Email Invite, Service, Logging, and Chat panes.

• About - Displays the version information for the Secure Virtual Assist client.

   Note Clicking the _ button in the bottom right corner of the Taskbar will minimize the view so only 
the titles of the buttons are displayed, and not the icons. Clicking the x button in the top right 
of the corner will close Virtual Assist.

You can also display additional shortcuts and controls by selecting View > Tab Controls for 
Current Customer. 

The following options appear at the top of the Virtual Assist window.

• Full Screen - Expands the Virtual Assist window to the Technicians entire monitor.

• Auto Scaling - Fits the customer’s screen to the Virtual Assist window.

• Zoom - Customizes the zoom of the customer’s screen.

• True Size - Zooms to the actual size of the customer’s monitor resolution.

• Gray Scale - Change the display to gray scale instead of full color. 

• Refresh - Refreshes the customer’s screen.

• File Transfer - Opens the File Transfer utility. See the “Using the Secure Virtual Assist File 
Transfer” on page 92 for more information.

• Chat - Opens a chat window with the customer.

• Record - Records the Virtual Assist session in a .wmv file that can be shared with other 
customers. The file is automatically named with the user name and the date and time the 
recording was started (for example, Sue_EST_2013-2-12_09h47m43s.wmv). The file 
location can be set on the Connection Settings window.

• System Info -Provides detailed information to the Technician about the customer’s 
computer.
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• Reboot Customer - Reboot the customer’s computer. Unless you have Requested full 
control, the customer will be warned about and given the opportunity to deny the reboot. 
You can select either a basic reboot or to reboot into Safe Mode with Networking.

    Note When rebooting, you will be prompted to enter the login credentials for the computer.

• Active Screens - Allows the Technician to switch to a second monitor if the customer’s 
computer has more than one monitor configured, or display all monitors.

• Request Full Control - Technicians can request full control of a customer’s desktop, 
allowing them to reboot the system, delete files, or over-write files on the customer’s 
computer without the customer being repeatedly prompted for permission. Select Request 
Full Control under the Commands menu to issue a request that will appear on the 
customer’s desktop.

Using the Windows Virtual Assist Taskbar and Tab Controls

In MacOS, the taskbar contains the following buttons:

• Refresh - Refreshes the display of the customer’s computer.

• Auto Scale - Adjusts the screen to fit the window size.

• Full Screen - Adjusts the screen to fill the entire window.

• System Info -Displays detailed information about the customer’s computer similar to that 
shown for a Windows computer.

• Reboot - Reboot the customer’s computer. Unless you have Requested full control, the 
customer will be warned about and given the opportunity to deny the reboot.
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• Chat - Launches the text chat window to communicate with the customer. The technician 
can also use the dedicated chat window in the bottom left window of the Secure Virtual 
Assist application.

• File Transfer - Launches a window to transfer files to and from the customer’s computer. 
see “Using the Secure Virtual Assist File Transfer” on page 92 for more information.

• Hide Toolbar - Hides the taskbar from view.

• Gray Color - Displays everything in grey monochrome

Using Additional Secure Virtual Assist Technician Commands

The Commands drop-down menu in the top left of the Virtual Assist window provides access 
to several of the options described above along with additional options.

• Open Remote System Info Window - Opens the System Info Window on the customer’s 
computer.

• Open Remote Task Manager Window - Opens the Task Manager on the customer’s 
computer.

• Send Ctrl+Alt+Del - Enters Control-Alt-Delete on the customer’s computer. 

• Open Remote Run Menu - Opens the Run menu on the customer’s computer.

• Open Remote Start Menu - Opens the Start menu on the customer’s computer.

• Send Alt+Tab to Remote - Enters Alt-Tab on the customer’s computer to toggle between 
open windows.

• Ctrl Key Down - Engages the Control key on the customer’s computer.

• Ctrl Key Up - Disengages the Control key on the customer’s computer.

• Alt Key Down - Engages the Alt key on the customer’s computer.

• Alt Key Up - Disengages the Alt key on the customer’s computer.
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Viewing Secure Virtual Assist Session Log

The Secure Virtual Assist Session Log window can be displayed by clicking the Logging button 
in the Taskbar. The log displays a history of timestamped events for the session, such as 
opening Chat or File Transfer, requesting Full Control, etc.

Using the Secure Virtual Assist File Transfer

 The File Transfer window is used to transfer files to and from the customer’s computer. The file 
directory of the Technician’s computer is shown on the left and the customer’s computer on the 
right.

The File Transfer window functions in much the same manner as Windows Explorer or an FTP 
program. Navigate the File Transfer window by double-clicking on folders and selecting files. 
The File Transfer window includes the following controls:

• Desktop  jumps to the desktop of the Technician’s or customer’s computer.

• Up  navigates up one directory on either the Technician’s or customer’s computer.

• Download  transfers the selected file or files from the Technician’s computer to the 
customer’s computer.

• Upload  transfers the selected file or files from the customer’s computer to the 
Technician’s computer.

• Delete  deletes the selected file or files.
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    Note When deleting or overwriting files, the customer is warned and must give the 
Technician permission unless the Technician has clicked the Request Full Control 
button and the customer has confirmed.

• New folder  creates a new folder in the selected directory.

• Rename  renames the selected file or directory.

When a file is transferring, the transfer progress is displayed at the bottom of the File Transfer 
window. Click the Exit button to cancel a transfer in progress.

   Note File Transfer supports the transfer of single or multiple files. It does not currently support the 
transfer of directories. To select multiple files, hold down the Ctrl button while clicking on the 
files.

Initiating a Secure Virtual Assist Session from the Customer View

The following sections describe how to initiate and use Virtual Assist on the three supported 
client platforms:

• “Initiating Secure Virtual Assist on a Windows Client” section on page 93

• “Initiating Secure Virtual Assist on a MacOS Client” section on page 97

• “Initiating Secure Virtual Assist on a Linux Client” section on page 100

• “Using Secure Virtual Assist” section on page 104

• “Using Secure Virtual Assist in Unattended Mode” section on page 106

• “Enabling a System for Secure Virtual Access” section on page 106

• “Using the Request Assistance Feature” section on page 110

Initiating Secure Virtual Assist on a Windows Client

To launch a Virtual Assist customer session to request help on your Windows computer, 
perform the following steps:

Step 1 There are several methods for accessing Virtual Assist:

• Navigate to the Virtual Assist home page using the URL provided by your Administrator or 
support Technician. 

• If you received an email invitation, click the link in the email or paste the URL into your Web 
browser.
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• The login page of your Virtual Office may include a direct link to Virtual Assist as shown 
below.

• Login to the Virtual Office and click the Request Assistance button.

• If set by an administrator, click the User Login link.
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• If Secure Virtual Assist has already been installed, select the Secure Virtual Assist shortcut 
from the Programs list under Window’s start button

Step 2 The first time you launch Secure Virtual Assist, you will be prompted to install the Secure Virtual 
Assist plugin and client.

Step 3 Click the Allow button. A plugin installation window displays. Click Install Now. The Secure 
Virtual Assist plugin and client installs. You may be prompted to restart your browser.

   Note Chrome browsers require installation of the plug-in from the Chrome store. 

Step 4 You can launch Virtual Assist either from the Virtual Office window or from a shortcut that is 
added to your Programs list under Window’s start button. If the Server address is not auto-
propagated in the login window, enter the Server address. The server address can be either an 
IP address, IPv6 address, or hostname of the Dell SonicWALL SRA appliance. IPv6 addresses 
must be enclosed in brackets (the [ and ] symbols).

Step 5 Click Request Support to request assistance or Appoint Technician to request assistance 
from a specific Technician. 

Step 6 If you receive the following security alert, click Unblock to allow Virtual Assist traffic through 
the Windows firewall.
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Step 7 If you selected Appoint Technician, a window listing all Technicians on duty appears. Select 
the Technician you would like to assist you and click Request Support.

Your service request will be displayed to all Technicians if you do not select a specific 
Technician. When you request a specific Technician, only that Technician will see your request.

Step 8 Select the portal for the requested Technician and click OK. If you do not select a portal, you 
will be assisted by any Technician.

After selecting a portal, a certificate prompt appears, followed by an assistance code and/or 
disclaimer if configured by the Administrator.

Step 9 A pop-up window indicates that you are in the Virtual Assist queue. The Technician will be 
alerted that you are ready. Click Cancel to cancel the Virtual Assist request.

Step 10 The Virtual Assist queue window provides two options:
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• Click the information to provide the Technician with information about your issue.

• Click the icon next to the Change Name line in the queue window to specify your name. By 
default, the computer name is used unless the customer responded to an email invite which 
displays the customer’s email address.

Step 11 When the Technician initiates the session, the Virtual Assist toolbar appears in the bottom right 
of your screen. The Technician now has control of your computer.

Step 12 For information on using Virtual Assist once the session is active, see “Using Secure Virtual 
Assist” section on page 104.

Initiating Secure Virtual Assist on a MacOS Client

To launch a Virtual Assist customer session to request help on your MacOS computer, perform 
the following steps:

Step 1 There are several methods for accessing Virtual Assist:

• Navigate to the URL of the Virtual Assist home page that is provided by your support 
Technician. 

• If you received an email invitation, click the link in the email or paste the URL into your Web 
browser.
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• The login page of your Virtual Office may include a direct link to Virtual Assist as shown 
below.

• Or you may need to login to the Virtual Office and click the Request Assistance button.

Step 2 The first time you launch Virtual Assist, you will be prompted to allow the Secure Virtual Assist 
applet to be installed on your computer. Click Allow.

Step 3 The Secure Virtual Assist client installs and launches. In the future, you can either launch 
Virtual Assist either by navigating to the Virtual Office window in your browser, or you can 
launch it directly from your Applications folder.

Step 4 If the Server address is not auto-propagated in the login window, enter the Server address and 
click Request Support. The server address can be either an IP address, IPv6 address, or 
hostname of the Dell SonicWALL SRA appliance. IPv6 addresses must be enclosed in brackets 
(the [ and ] symbols).
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Step 5 The list of Available Portals is displayed. To connect to a specific portal, select it and click OK. 
To have your request be serviceable by all of the portals, click OK without selecting a specific 
portal.

Your service request will be displayed to all Technicians if you do not select a specific 
Technician. When you request a specific Technician, only that Technician will see your request.

Step 6 You may be prompted to enter an Assistance Code.

Step 7 If prompted to read and accept a disclaimer, click OK.

Step 8 A pop-up window indicates that you are in the Virtual Assist queue. The Technician will be 
alerted that you are ready. Click Cancel to cancel the Virtual Assist request.
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Step 9 The Virtual Assist queue window provides two options:

• Click Add information to provide the Technician with information about your issue.

• Click the icon next to the Request Name line in the queue window to specify your name. 
By default, the computer name is used.

Step 10 When the Technician initiates the session, the Virtual Assist toolbar appears in the bottom right 
of your screen. The Technician now has control of your computer.

Step 11 For information on using Virtual Assist once the session is active, see “Using Secure Virtual 
Assist” section on page 104.

Initiating Secure Virtual Assist on a Linux Client

   Note Dell SonicWALL Secure Virtual Assist is fully tested on the Ubuntu distribution of Linux. It 
has not been tested on other Linux distributions.

To launch a Virtual Assist customer session to request help on your Linux computer, perform 
the following steps:

Step 1 There are several methods for accessing Virtual Assist:

• Navigate to the URL of the Virtual Assist home page that is provided by your support 
Technician. 

• If you received an email invitation, click the link in the email or paste the URL into your Web 
browser.

• The login page of your Virtual Office may include a direct link to Virtual Assist as shown 
below.
100 | SRA 7.5 User Guide



• Or you may need to login to the Virtual Office and click the Request Assistance button.

Step 2 You will be prompted to click the Virtual Assist Client Download for Linux button. It will 
prompt you to download the “VACLinux.x86.tgz” file. Unpackage the file and run the “Install” 
file. You can now launch Virtual Assist either from a shortcut on your desktop or by typing 
VirtualAssistGui in the Terminal window. 

Step 3 Optionally, you can enter your name and a summary of your issue and click Request Support. 
You will then be prompted to install the Secure Virtual Assist client. After the installation is 
complete, the Secure Virtual Assist client will launch automatically. 
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Step 4 You can now launch Virtual Assist either from a shortcut on your desktop or by typing 
VirtualAssistGui in the Terminal window.

Step 5 If the Server address is not auto-propagated in the login window, enter the Server address and 
click Request Support. The server address can be either an IP address, IPv6 address, or 
hostname of the Dell SonicWALL SRA appliance. IPv6 addresses must be enclosed in brackets 
(the [ and ] symbols).
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Step 6 The list of Available Portals is displayed. To connect to a specific portal, select it and click OK. 
To have your request be serviceable by all of the portals, select All Portals and click OK.

Step 7 You may be prompted to enter an Assistance Code.

Step 8 If prompted to read and accept a disclaimer, click OK.

Step 9 A pop-up window indicates that you are in the Virtual Assist queue. The Technician will be 
alerted that you are ready. Click Cancel to cancel the Virtual Assist request.

Step 10 The Virtual Assist queue window provides two options:
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• Click Add information to provide the Technician with information about your issue.

• Click the icon next to the Request Name line in the queue window to specify your name. 
By default, the computer name is used.

Step 11 When the Technician initiates the session, the Virtual Assist toolbar appears in the bottom right 
of your screen. The Technician now has control of your computer.

Step 12 For information on using Virtual Assist once the session is active, see “Using Secure Virtual 
Assist” section on page 104.

Using Secure Virtual Assist

During a Virtual Assist session, you are not completely locked out of your computer. Both the 
Technician and customer can control the computer, although this may cause confusion and 
consternation if they both attempt to “drive” at the same time. You can resume control when the 
Technician is not actively typing or moving the mouse. And you can end the session at any time 
by clicking the End Virtual Assist button in the bottom right corner.
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Chatting with the Technician

To start chatting with the Technician assisting you, click the Chat button or enter Alt-c, which 
opens an instant message chat session with the Technician. The Technician can also open a 
Chat window to communicate with you. 

To chat, type text in the Chat window and type Enter or click Send.

Changing the Secure Virtual Assist Level of Control 

There are three levels of control that a customer can grant to the Technician:

• View Only - The Technician can view the customer’s computer but cannot control it. To 
switch to View Only mode, click the Status (Active) button. The Status switches to (View 
Only).

• Active - The Technician can control the customer’s computer, but the customer must give 
permission for certain action—such as allowing the Technician to reboot the system, delete 
files, or over-write files on the customer’s computer without the customer being repeatedly 
prompted for permission. To switch from View Only mode to Active mode, click the Status 
(View Only) button. 

• Trusted - The Technician has complete control of the customer’s computer. To toggle 
between Trusted mode and Active mode, enter Ctrl-Alt-T.

   Note By default, Virtual Assist sessions are launched in Trusted mode. To modify this mode:

1. Click the Settings button on the top left corner of the window.

2. Select the Connection Settings tab.

3. Select either Auto View Only or Active Mode.

Ending a Virtual Assist Session

You can end the Virtual Assist session at anytime by clicking on the Exit Virtual Assist button 
in the bottom right corner of the screen, or by entering Alt-q. This will end the Technician’s 
control of your computer.
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Using Secure Virtual Assist in Unattended Mode

   Note Unattended Mode is supported only on Windows clients.

Unattended Mode allows customers to set their computer to be accessible by a Technician at 
a later time when the customer will not be available to click to confirm their consent. To set your 
computer for Secure Virtual Assist Unattended Mode, perform the following tasks:

Step 1 Launch Virtual Assist.

Step 2 Click Change Mode, select Unattended, and click Change Mode again.

Step 3 Select or enter the IP address or domain name of the SSL VPN server.

Step 4 Enter a Password and click Login. The Waiting window displays and shows the length of time 
you have been in the queue. 

Step 5 You need to provide the Technician with the password you just defined. An easy way to do this 
is to click Add Information and give the Technician your password.

Enabling a System for Secure Virtual Access

   Note Secure Virtual Access is supported only on Windows clients. Secure Virtual Access is 
installed automatically when Secure Virtual Assist is installed and can be accessed from the 
Programs list under the Window’s start button.

Secure Virtual Access is similar to Secure Virtual Assist Unattended Mode in that Administrator 
privileges are required to install these client features, and a Technician is prompted to provide 
the password established during set-up to gain access to the system.

If Secure Virtual Access has been enabled on the Virtual Assist tab on the Portals > Portals 
page of the management interface, users should see a link on the Virtual Office portal to set up 
a system for Secure Virtual Access. The following process allows Secure Virtual Access to be 
set up on a system.
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Step 1 Login to the Virtual Office portal through the system you wish to set up for Secure Virtual Access 
and click the Virtual Access link.

Step 2 A file should download with parameters to install the VASAC.exe file that will provide the 
needed client for Secure Virtual Access mode. Save and run the file.

   Note Running the file directly from this dialog box may not work on some systems. Save the file 
to the system and then run the application.

Step 3 Fill in the necessary information in the provided fields to set-up the system in Secure Virtual 
Access mode and click OK.

• Server: This should be the name or IP address of the appliance the Technician normally 
accesses the Virtual Office from outside the management interface (Do not include     
“https://”).

• Computer Name: This is an identifier for the system to help differentiate between other 
systems that may be waiting for support in the queue. This name will appear as a bookmark 
name in the user portal of the owner.

• Owner Name: This name must be a valid SRA appliance user name.

• Key: This is a key the Technician must enter prior to accessing the system through the 
support queue.
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Step 4 When prompted, enter the name of the Portal the Technician would normally login to.

Step 5 After installation, the VASAC client should be left running in the desktop tray.

This system’s identifier name should now appear in the Technician’s support queue displayed 
on the Secure Virtual Assist > Status page within the management interface.Upon double-
clicking the system listing, the Technician will be prompted to provide the password established 
during system setup to gain Secure Virtual Access to the system.

Using Wake on Lan

When operating in Secure Virtual Access mode, a customer can allow a Technician to wake a 
client running Virtual Assist on the LAN if both are in the same subnet. The client can be woken 
when powered off, in the Sleep state, or in the Hibernate state. This feature can be enabled 
globally, per portal, or from the client.

Note To enable Wake Client, this feature must also be enabled on the portal and in the 
BIOS of the client machine.

To enable Wake on Lan:

Step 1 Configure Wake on Lan in the client PC BIOS by selecting the Wake-on-LAN option.

Step 2 Configure Wake on Lan in the client PC Device Manager:
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1. Open Device Manager by right-clicking the Computer icon on the client PC desktop, 
selecting Properties from the drop-down list, and then selecting Device Manager.

2. Expand the Network adapters folder and select the Network Connection used for Virtual 
Access.

3. Click the Power Management tab and check the Allow the device to wake the computer 
check box.

4. Click OK.

Step 3 While in the Secure Virtual Access mode, select Enable WOL from the Virtual Access menu.

If the client PC sleeps, shuts down, or hibernates, the pending client enters the Offline state, 
where it can be woken by a Technician.

Step 4 Next, a Virtual Assist Technician double-clicks the customer’s entry in the Pending List and the 
client PC is woken automatically. 

   Note If the client PC cannot be woken, reinstall the Wake-on-Lan software, and reconfigure the 
client PC. 
The customer may end the service session at any time.

Ending Secure Virtual Access Mode
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Disconnecting from a Secure Virtual Access session will place the system back in the support 
queue for later access by the Technician. From the personal system-side, the user/Technician 
may uninstall or terminate the application from the tray option icons.

An Administrator can forcibly remove a system from the queue. If this occurs, the Secure Virtual 
Access system should no longer attempt to connect to the support queue and should display 
an error message.

Using the Request Assistance Feature

If the Display Request Help Button option has been enabled on the Virtual Assist tab on the 
Portals > Portals page of the management interface, users will see the Request Assistance 
button on the Virtual Office portal. By clicking this button on the portal, the user is placed in the 
Virtual Assist support queue for assistance. 

For information on using Virtual Assist from the customer perspective, see “Initiating a Secure 
Virtual Assist Session from the Customer View” on page 93.
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Using Secure Virtual Meeting
To set up a Virtual Meeting the meeting Coordinator performs the following steps:

• Log in

• Schedule a meeting

• Invite meeting attendees

• Optionally, create a poll for the invited attendees

• Start the meeting

• Use meeting features during a meeting

• End the meeting

The functions you are allowed to perform depend on your role and whether a meeting is in 
progress. The following sections describe roles and how to use Secure Virtual Meeting:

• “Installing and Launching Secure Virtual Assist” section on page 80

• “Configuring Secure Virtual Assist Settings” section on page 81

• “Selecting a Secure Virtual Assist Mode” section on page 84

User Roles

Secure Virtual Meeting has several user roles:

• Coordinator (Owner of the meeting) - The Coordinator must be a Dell SonicWALL SRA 
user on the appliance. The Coordinator schedules, sets up, and controls the meeting. In 
addition, the Coordinator has the sole power to promote a Participant to the Assistant.

• Assistant (Coordinator-designated Assistant) - The Coordinator selects an Assistant from 
the list of available Participants and assigns the Assistant privileges. When the Coordinator 
exits the meeting, the Assistant automatically becomes the Coordinator. A meeting may 
have multiple Assistants, each with the same or a different set of privileges. An Assistant 
need not be a user of the SSL-VPN appliance. Possible Assistant privileges are:

– Start/End Meeting 

– Set Host

– Open Polling

– Share Files

– Set/Unset View Only

– Invite Participants

– Kick out Participants

– Reschedule Meeting

• Host - The Host is a Participant who shares their desktop with all Participants in the 
meeting. When a meeting begins, the Host’s desktop is shown to all Participants. 

The Host can be changed by the Coordinator during the meeting by selecting any available 
Participant. If a Host is not explicitly set when the meeting starts, the Coordinator becomes 
the Host. Only one Participant is designated as the Host at any one time. 

Only the Host can control the Host System, unless the Host grants permission when a 
Participant requests control. The Host may also give control to any Participant by selecting 
the Participant from the Meeting Members list. Only one Participant can control the Host 
System at any one time. When a Participant takes control of the Host System, he loses 
control as soon as the Host moves his mouse pointer on the screen. The meeting control 
permission state is visible to all Participants while in the lobby.
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• Participant (User with credentials to join the meeting) - A Participant must enter a meeting 
code before they can join a meeting. The code required to join the meeting is determined 
by the Coordinator prior to the meeting. After joining a meeting, the Participant can view the 
shared desktop and chat with another attendee privately or type a message in the Chat 
window that is visible to all attendees. A Participant becomes the Assistant if selected by 
the Coordinator or by an Assistant who has the required privilege.

• View-only Participant (User with limited meeting capabilities) - The Coordinator may 
designate any Participant as a View-only Participant. A View-only Participant cannot be 
assigned any privileges nor become an Assistant or Host.

Roles are switched before or during a meeting. A Coordinator or Assistant with necessary 
privileges can change the roles of any Participant during the meeting. A Participant wishing to 
become the Host must request permission from the Coordinator.

Coordinator Role

The Virtual Meeting Coordinator performs the following tasks:

Coordinator Tasks Description

Log In Log in from a Virtual Meeting client using SRA credentials.

Set Up a Meeting Set up a meeting by scheduling a time and creating a meeting code that 
allows meeting members to join the meeting.

Perform Lobby Functions Access various meeting functions in the lobby before or during a meeting.

Control Roles Control what meeting members may do and appoint an Assistant to help 
facilitate the meeting.

Revise Meeting Settings Set up a proxy or modify login profiles for meetings.

Log Actions and Mes-
sages

Review a log of actions that occurred and view any warning or error message 
details that may require attention.

Start a Meeting Start a meeting immediately or at the scheduled time.

Use the Control Menu 
During a Meeting

Access functions available while a meeting is active.

Create Email Invites Invite meeting members through email before or during a meeting.

Poll Participants Create a poll for attendees to participate in.

Share Files Share a file with Participants that they can download.

Text Chat Chat with everyone or specific individuals in a meeting.

Share Desktop Share specific windows or all of your desktop with Participants.

Use a White Board Display a white board where objects, text, and highlighting can be added and 
view by Participants.

Record meetings Record meeting sessions in a .wmv file.

Start Voice Conversations Start a conversation where Participants can hear you.
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Logging In

A Participant can join a Virtual Meeting by clicking a link in the email invite or by logging into 
the Virtual Meeting client if the Administrator has enabled Join Without an Invitation on the AMC 
Secure Virtual Meeting > Settings page. To login from an installed Virtual Meeting, click the 
Host button.

Only SRA users can be a Coordinator under normal circumstances, so SRA credentials are 
required for Coordinator login. However, a non-SRA user can become the Coordinator if the 
Participant is chosen as an Assistant and the Coordinator quits the meeting.

The meeting application can alternatively be accessed directly from the Virtual Office on an 
SRA 4600, SRA 4200, and Virtual Appliance. 

A Domains drop-down list is displayed if the user belongs to multiple domains, and a Portals 
drop-down list is shown if Virtual Meeting is enabled on multiple portals. Otherwise, the domain 
and portal is automatically selected.

Select the desired portal to be used for the meeting. Only Participants who are in the selected 
portal will be able to join the meeting.
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Setting up a Meeting

Once logged into the system, the option to create a meeting is available. If a meeting is already 
created you may view the details of the meeting by right-clicking the desired meeting and 
selecting Properties.

To create a meeting, click the Create button to display the meeting creation interface.

To set up a meeting enter a Meeting Name, Meeting Code, Starting Date and Time, and 
Ending Date and Time. The meeting code will be entered by all Participants wishing to join the 

meeting. If you want to invite attendees and the Email fields are not visible, click the  down 
arrow button directly below the Ending Date field. You can then identify who should receive 
meeting email invitations.
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Use the buttons across the bottom of the window to perform the following functions:

After you create a meeting, you enter the meeting’s lobby automatically.

When a meeting is scheduled for a later time, the Coordinator exits the meeting and returns to 
the lobby at the meeting start time. If the Allow starting meeting without meeting creator setting 
is disabled and the Coordinator has not joined the meeting by the start time, the participants 
will be kept waiting in the lobby until the scheduled meeting end time (when all participants 
automatically exit the lobby). If the Allow starting meeting without meeting creator setting 
is enabled and the Coordinator has not joined the meeting by the start time, within two minutes 
past the scheduled start time, an existing participant is chosen randomly to become the 
Coordinator.

If the Coordinator enters but does not start the meeting, when the meeting time ends the 
Coordinator receives a notification to reschedule or end the meeting. When the end time is 
reached, the meeting ends and all meeting members automatically exit the meeting.

Save Saves the meeting for future editing.

View Displays previously saved meetings.

Start Now Starts the meeting immediately with the current user system time, and 
enter the lobby.

OK Start the meeting immediately at the next available time slot (based on 
the current time), and enter the lobby.
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In the lobby you can manage the meeting, set roles, and many other functions described in 
“Performing Lobby Functions” on page 116, depending on your role.

Performing Lobby Functions

The following functions can be performed from the lobby by clicking buttons at the top:

 Clicking the Start Meeting button starts the meeting. Only the Coordinator and 
Assistant can start a meeting. 

 When a meeting is started, the Start Meeting button changes to the Stop Meeting 
button. Clicking the Stop Meeting button ends the meeting. Only the Coordinator and 
Assistant can end the meeting.

Clicking the Polling button opens the polling window where you can load, edit, and start 
a poll for Participants currently in the meeting. Only the Coordinator and Assistant can 
initiate polling. Polling details are described in“Polling” on page 123.

Clicking the White Board button displays a white board to all meeting Participants 
where the Coordinator can add objects, text, and highlighting. White board is available 
only during a meeting. White board details are described in“Using a White Board” on 
page 125.

Clicking the File Share button opens the file share window where you can select files for 
Participants to download and monitor Participants’ downloads. Only the Coordinator and 
Assistant can initiate file sharing. Details are described in“File Sharing” on page 126.

Clicking the Start Voice Conversation button shares voice communication with 
Participants in the meeting lobby. Only the Host can be heard. Voice Conversation 
details are described in“Starting Voice Conversation” on page 127.

When a voice conversation is started, the Start Voice Conversation button changes to 
the Stop Voice Conversation button. Clicking the Stop Voice Conversation button 
ends voice communication. Voice Conversation details are described in“Starting Voice 
Conversation” on page 127.

Clicking the Invite button sends an email invitation to Participants. Only the Coordinator 
and Assistant can invite Participants. Invite details are described in “Creating Email 
Invites” on page 122.

Clicking the Start Sharing button shares the Host desktop with all Participants in the 
meeting. Sharing is only available during a meeting.

When a desktop is being shared, the Start Sharing button changes to the Stop Sharing 
button. Clicking the Stop Sharing button stops sharing the Host System desktop. Only 
the Host can stop sharing.

Clicking the Request Control button requests that the Host give you control of the 
keyboard and mouse. Only Participants who aren’t the Host can request control.

.Clicking the Reschedule Meeting button reschedules the meeting start and end times. 
Only the Coordinator and Assistant can reschedule a meeting.

Clicking the Request Host button informs the Host that you want to become the Host 
and share your desktop. Only Participants who are not currently the Host can request to 
become the Host.

Clicking the Quit button exits the meeting and return to the meeting selection window. 
Anyone in the meeting can quit the meeting. 
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Controlling Roles

The Coordinator and Assistant can change a meeting member’s role by right clicking the 
meeting member’s name and selecting a role from the drop-down menu.

The following options may appear, depending on permissions and the meeting member’s 
current role.

.

Option User Description

Pass Keyboard and 
Mouse Control

Host Allow the selected Participant to control the Host’s PC.

Set as Host Coordinator
Assistants with Set Host permission

Set the selected Participant to be the Host.

Set as Assistant Coordinator Set the selected Participant to be the Assistant. An 
Assistant has privileges similar to the Coordinator, 
depending on the settings selected by the Coordinator as 
shown below.

Set as view-only Coordinator
Assistant

Set the selected Participant to view-only mode so the 
Participant can only view the Host desktop (cannot 
request control).

Kick out Coordinator
Assistant

Remove the selected Participant from the meeting.
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Revising Meeting Settings

Proxy Settings

For setups that require a proxy, click the Settings tab in the Virtual Meeting window, and check 
the Enable Proxy Settings check box.

Enter the proper information to utilize the proxy or click the Internet Explorer proxy settings 
button to automatically import the proxy settings used by Internet Explorer.

Connection Profiles

For users accessing different appliances, profiles are shown on the Connection Profiles 
window. Information about the server currently in use is automatically populated for 
convenience.

To remove all connection profiles, click the Remove All button. To remove a specific connection 
profile, select the connection profile and click the Remove button.
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General Settings 

The General Settings tab is used to select the location where recordings will be saved, select 
the Voice Transmission method, and enable or disable the Participant Mark feature.

To change the default settings:

• Click the  Browse button and select the location where you want to save meeting 
recordings.

• Select the protocol to use for transmitting voice conversations from the Voice 
Transmission Method drop-down list.

• Check the Enable the participant mark check box to enable this feature. The Participant 
Mark feature, which is enabled by default, allows Participants to double-click something on 
the Host’s desktop while it is being shared to call the Host’s attention to it. The Participant 
Mark is displayed on the shared desktop in the area where the Participant double-clicked. 
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Logging Actions and Messages

The Log Viewer displays all event log data, which includes actions taken during a meeting and 
any errors that occur. The Log helps you keep track of events that occur in a meeting and shows 
all actions performed by meeting Participants. Use the error and warning events in the log to 
take the appropriate corrective action, if necessary.

Using the Control Menu during a Meeting

The Control Menu is available at the top of a shared desktop when the Host shares the desktop 
during an active meeting.

The Invite button is available for the Coordinator or Assistants with invite permission. It 
opens the invite dialog if the lobby is not open. Invite details are described in “Creating Email 
Invites” on page 122.

The Polling button is available for the Coordinator or Assistants with polling permission. 
It opens the polling dialog detailed in “Polling” on page 123.

The Chat button is available for all Participants, including View-only Participants. It opens 
a chat dialog if the lobby is not open. Chat details are described in “Text Chatting” on page 128.
120 | SRA 7.5 User Guide



The Lobby button is available for all meeting members, including View-only Participants. 
If the lobby is hidden during a meeting, it displays the lobby window when the Host is sharing 
the screen.

The Options button opens the Meeting Settings window described in “Revising Meeting 
Settings” on page 118 and is available for all Participants.

The Viewer button is available for all Participants except the Host. It toggles the window 
between the Participant’s window and the Host’s desktop.

The About button opens the About dialog, which identifies the Secure Virtual Meeting 
client and version. The About button is available for all meeting members, including View-only 
Participants.

In addition, Participants can double-click something on the Host’s desktop while it is 
being shared to call the Host’s attention to it. The Participant Mark will be displayed on the 
shared desktop in the area where the Participant double-clicked. This feature, which is enabled 
by default, is enabled/disabled on the Settings > General Settings tab.

The drop-down arrow shown on the right of the Control Menu opens a list of additional features: 
Per-App Sharing, White Board, and Annotation:

Per-App Sharing allows the Coordinator to select specific windows to share with meeting 
Participants instead of sharing the entire desktop. Selecting this feature displays a window 
where the windows are chosen.
Using Secure Virtual Assist | 121



White Board displays a white board and is also displayed on the Lobby toolbar. See “Using a 
White Board” on page 125 for additional information.

Annotation allows any meeting Participant to add text, objects, and highlighting to a white 
board using the white board toolbar, as described in “Using a White Board” on page 125.

Creating Email Invites

Invitations can be sent when creating the meeting or while in an active meeting.

   Note Email settings must be configured in the management console Log > Settings page before 
Virtual Meeting email can be sent.
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To invite someone to a Virtual Meeting, enter the email address and click Invite. Additional 
fields are optional. Invited users receive an email similar to the following:

After receiving the email invitation, attendees click the link in the email, which accesses the 
appliance to join the meeting. If the Secure Virtual Meeting plug-in is installed, it automatically 
downloads and launches the application and puts the attendee into the meeting. Alternatively, 
attendees can manually download the Secure Virtual Meeting plug-in and run it as an 
application. Both cases will provide meeting access.

Polling

Click the  Open Polling button to display the Polling window where you can create polls 
and define the polling questions.
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Create new questions by clicking the  and  buttons. There are three 
question types: 

• Multiple choice (single answer)

• Multiple choice (multiple answer)

• Short answer

Use the buttons at the top of the window to:

The Open Virtual Meeting Poll Files button opens any saved polling questions and 
possible answers.

The Save Virtual Meeting Poll File button saves the current polling questions and 
answers.

 The Edit button is used to edit the currently selected polling question or answer.

The Clear button erases ALL polling questions and answers.

The Up and Down buttons change the order of the selected questions or possible 
answers.

Click the  button to start polling and send the poll to the selected Participants to 
answer.
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Polling feedback window

Feedback from the poll is returned to the poll initiator when answers are submitted and when 
the End Polling button is clicked. The collected feedback is displayed as shown below. Click 
the green bar to display detailed information for each answer.

Using a White Board

The Host can share a white board with Participants. Text, objects, and highlighting, which can 
be customized, are added to the white board using the toolbar at the top of the white board.

The white board contains the following tools:

Select tool is a pointer used to point to objects on the white board. The user cannot add 
anything on the white board until another tool is selected.

Pen tool is used to draw a freehand shape. The pen’s color (default black) and line width 
(1-100pt, default 8pt) are configurable with the Customization tools.

Highlighter tool is another kind of pen used to draw a transparent freehand shape. The 
highlighter width (1-100pt, default 16pt) and transparency saturation (1-100, default 50) is 
configurable with the Customization tools. The transparency saturation is adjusted by 

Line tool draws a straight line. The line color (default black) and weight (1-100pt, default 
10pt) are configurable with the Customization tools.
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Rectangle tool draws a rectangle. The rectangle edge color (default black), fill color (default 
transparent), and edge weight (1-100pt, default 5pt) are configurable with the Customization 
tools.

Ellipse tool draws an ellipse on the white board. The ellipse color (default black), fill color 
(default transparent), and edge weight (1-100pt, default 5pt) are configurable with the 
Customization tools.

Text tool adds text on the white board. The text’s color, font, font size, and style (default 
Arial 20pt) are configurable with the Customization tools.

Eraser tool erases anything on the white board. The eraser width (default 20pt) is 
configurable with the Customization tools.

Clear All Contents tool erases all contents on the white board.

Customization Tools: 

File Sharing

The Host can share files with Participants during a meeting. Click the  File Sharing button 
to display the File Sharing window where you can select a file to share with Participants and 
monitor downloads.
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To share a file, select File > Select File from the menu on the Sharing File window and select 
the file. By default, the file will be shared with all meeting Participants. To share the file with 
specific meeting Participants select Customize. Next, click Publish to notify Participants that 
a file is available for download.To change the list of Participants who can download the file, 
right-click the file and select Setting at any time. To remove the file from the download list, right-
click the file and select Remove at any time.

 When a file is published, the selected Participants receive a notification in the lower right corner 

of their screens. Download the file by clicking the  File Sharing button, right-clicking the 
file and selecting Download, and then right-clicking the file and selecting Open once the file 
has been downloaded,

Starting Voice Conversation

The Coordinator can share one-way voice communication with meeting Participants. Only the 
Host can be heard. When voice communication is started an icon appears on the Meeting 
Members section of the Lobby window next to each meeting Participant.

To use voice communication:

1. Click the Start Voice Conversation button to open voice communication with 
Participants in the meeting lobby.

2. When a voice conversation starts, the Start Voice Conversation button changes to 
the Stop Voice Conversation button. Click the Stop Voice Conversation button to end 
voice communication. 
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 Text Chatting

Chat with all attendees in the meeting or have a private chat with one or more selected 
attendees, including View-only Participants.

If the lobby is hidden, click  on the control menu once the meeting has started and the Host 
is sharing the screen. The chat window is displayed in a stand-alone chat window.

Recording a Meeting

Any meeting Participant can record the meeting screens in a .wmv file. The file is automatically 
named with the Host’s name and the date and time the recording was started (for example, 
Holi_EST_2013-2-12_09h47m43s.wmv). The file location can be set on the Connection 
Settings window.

To record a meeting:

1. Click the  Record button to start recording, which displays recording controls at the 
bottom right of the window.

2. Use the recording controls to Start, Pause, and Stop the recording. 

3. When recording starts, the  Record button changes to the Stop Recording button. 
Click the Stop Recording button to end recording.

 Participant Role

Participants can be designated as View-only Participants or regular Participants. View-only Participants enter and 
exit meetings like other Participants, but cannot perform most functions. However, they can be kicked out of 
meetings like other regular Participants. Regular Participants can also:

• Respond to polls

• Download shared files

• Text chat

• Request control of the Host keyboard and mouse

• Request to become the Host and share the Participant’s desktop

• Become the Assistant

• Become a View-only Assistant
128 | SRA 7.5 User Guide



Login

Participants click the link from the meeting email invitation or type the server name or IP 
address in the Server field of the Secure Virtual Meeting window.

If necessary, select the proper meeting portal. All available meetings are displayed.

Select the meeting to join and click the Join button. The following prompt is displayed if you 
are required to enter a meeting code to join the meeting.
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Enter the meeting code that was provided in the meeting email invitation and click the OK 
button to join the meeting. After joining the meeting, you will be in the meeting lobby. 
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Chapter 6

 Using File Shares

File shares provide remote users with a secure Java applet or HTML-based interface to 
Microsoft File Shares using the CIFS (Common Internet File System) or SMB (Server Message 
Block) protocols. Using a Web interface similar in style to Microsoft’s familiar Network 
Neighborhood or My Network Places, File Shares allow users with appropriate permissions to 
browse network shares, rename, delete, retrieve, and upload files, and to create bookmarks for 
later recall.

The File Shares Applet mimics Windows Explorer navigation and provides functionality not 
available in HTML-based File Shares, including the ability to overwrite existing files and upload 
directories.

This section contains the following subsections:

• “Using the File Shares Applet” section on page 131

• “Using HTML-Based File Shares” section on page 143

Using the File Shares Applet 
The File Shares Applet has a similar look and feel to the Windows Explorer tool, featuring drag-
and-drop and multiple file selection capabilities. It also provides the user the ability to set up 
bookmarks to quickly navigate through networks from the portal level. This feature saves time 
lost moving through network and server paths. The File Shares Applet leverages Sun’s Java 
platform browser plug-in to increase usability by mimicking the common Windows Explorer 
interface. With the help of the HTTPS protocol, the applet securely transfers encrypted files and 
information to and from the SRA appliance. The appliance communicates this data to the 
individual machines on the remote network. 

This section contains the following subsections:

• “User Prerequisites” section on page 131

• “Configuration Overview” section on page 132

• “Configuration Examples” section on page 137

User Prerequisites

The Dell SonicWALL SSL VPN File Shares Applet is a Java application that supports Java 1.3.1 
and newer, and the JRE Version 5.0 Update 10 or newer is recommended. To download the 
latest Java and JRE versions, visit http://www.java.com.

Supported Web browsers for SRA and Java File Shares are listed in “Browser Requirements” 
on page 10. For optimal performance, use the most recent supported version shown in this list.

The Administrator must enable the File Shares Applet for users to use it. 

There must be a computer with open access for the Dell SonicWALL SSL VPN File Shares 
Applet to log into. The remote computer must have shared folders for files to be copied or 
moved. Sharing policy must be set from within the remote computer’s own operating system.
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Configuration Overview

The SSL VPN File Shares Applet is easy and intuitive to use. User should be aware of its 
functions and limitations. Setting up bookmarks and the browser interface are covered in this 
section, along with an overview of the browser and sample use cases. 

This section contains the following subsections:

• “Setting up Bookmarks” section on page 132

• “Using the Java File Shares Applet” section on page 134

• “File Shares Applet Browser Overview” section on page 136

Setting up Bookmarks

Bookmarks can be set up for folders and for files. A file bookmark will not launch the Applet, 
but instead will download and launch the file directly. Bookmarks must be enabled by the 
Administrator. To set up bookmarks from the Virtual Office Portal, perform the following steps. 

Step 1 Open a Web browser and log into the SSL VPN Virtual Office interface by typing the URL in the 
Location or Address bar and press Enter. Type in your user name in the User Name field and 
your password in the Password field, then select the appropriate domain from the Domain 
drop-down. Click Login.

Step 2 Click the Show Edit Controls link in the middle of the portal page. 

Step 3 Click the New Bookmark tab in the portal page.
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Step 4 The Add Bookmark screen displays. Enter a friendly name for the bookmark in the Bookmark 
Name field.

Step 5 Enter the IP address and file directory path to the File Share in the Name or IP Address field. 

    Note When using the Java applet, the Name or IP Address field must be to a file directory 
and end with a / or \ character.

Step 6 In the Service pull down menu, select the File Shares (CIFS) option.

Step 7 Check the Use File Shares Java Applet box to enable the File Shares Applet for this 
bookmark. Leaving this box unchecked means the portal will launch the original HTML browser 
when the bookmark is selected.

Step 8 Optionally, select Automatically log in to log in to this file share using either your SSL VPN 
credentials or by specifying custom credentials.

Step 9 Click Add.

Bookmark serve as useful shortcuts to quickly access different network locations. Bookmarks 
can also be set up from the File Shares Browser, either by clicking the Bookmark button, or 
using the bookmark option from the right-click menu.
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Using the Java File Shares Applet

While loading the browser interface, warning messages might display. These messages will 
look different for different browsers. For the purpose of these examples, Internet Explorer 6.0 
was used.

Step 1 If you are not logged into the SSL VPN Virtual Office user interface, open a Web browser and 
type the Virtual Office interface URL in the Location or Address bar and press Enter. Type in 
your user name in the User Name field and your password in the Password field, then select 
the appropriate domain from the Domain drop-down menu. Click Login.

Step 2 Launch File Shares Applet by clicking the File Shares button, or clicking on a link with the File 
Shares Applet enabled. The File Shares Applet will launch in a new window, separate from the 
Virtual Office portal.

Step 3 Depending on available browser and Java plug-in, a warning may display, click OK to continue. 

    Note To avoid this warning, upgrade browser to Internet Explorer 8.0 or newer, Firefox 
16.0 or newer, Chrome 22.0 or newer, or Safari 5.0 or newer. Also updates to Java 
5.0 Update 10 or newer are recommended.

Step 4 Depending on the networks configurations and browser, one or more security warnings may 
display. Follow the instructions to accept the certificate for the server. 
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The File Shares Applet displays.

    Note The File Shares Applet window will not automatically refresh when its contents have 
changed or if it has been previously viewed. To refresh, click the Refresh icon from 
the toolbar, or use the Refresh option from the right-click menu.

    Note The remote network can be browsed from the remote window’s address bar. The 
local directory can not be changed from the address bar. The remote path is capped 
at 1024 characters. The actual maximum string size will change depending on 
language.

Step 5 To select multiple items, click the items while holding the shift or the ctrl key. Clicking on an 
item again will de-select it and remove it from the group.

Step 6 To copy a file or group of files either to or from the network, select desired items and click-and-
drag them across the center boundary. This will copy the file(s) into the open directory. 
Alternatively, the file(s) can be copied directly into a folder by dragging the icon and dropping 
over the desired folder; one could also use the copy button on the toolbar, or use the copy 
option from the right-click menu. A progress bar displays the waiting time required to copy the 
files. 
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    Note The File Shares Applet supports overwriting existing files. If a file exists with the 
same name as the one you are trying to copy over, the Applet will prompt you to 
rename the file being copied. If the name is kept the same, the copied file will 
overwrite the existing one.

Step 7 Double-click a file to launch it with the proper application. If activating a file on the remote 
machine, the File Shares Applet will first download the file to a temporary folder on your 
machine and then open it. 

The File Shares Applet will not always be able to delete the temporary file after use. Use caution 
when opening files with sensitive material. 

File Shares Applet Browser Overview

Each window, local and remote, contains a set of buttons for commonly used operations in the 
toolbar. Hovering the mouse cursor over these icons displays convenient tool tips to the user. 
Dragging the toolbar by the dotted line on the left side of it undocks the toolbar into its own 
window. To re-dock the toolbar, close the window. These are the same functions as those in the 
right-click menu.

Here is a list of the buttons on the task bar and their respective function.

• Back: Traverses back in the history. Sets the current view of the window to the previous 
location in history. This icon is dimmed if there is no previous history location.

• Forward: Traverses forward in history. This icon is dimmed if there are no forward locations 
in history.

• Up: Traverses up the directory tree to the parent directory of the current view. This icon is 
dimmed if the current view is of the root directory or if the parent directory cannot be 
resolved.

• Refresh: Refreshes the current view by either polling the local file system or remote 
network via the SSL VPN. The refresh icon will be dimmed in the remote window if its 
contents are currently being refreshed.

• New Folder: Creates a new folder within the respective file system. Clicking this icon 
displays the “New Folder” dialog box, allowing the user to assign a name to the new folder. 
This icon is dimmed when the location of the window is such that a new folder cannot be 
created. (for example, Root of a Windows filesystem, domain list, machine list).

• Copy: Copies the selected file(s)/folder(s) to the location of the remote window. Clicking 
this icon displays the “Copy” dialog box that will show the status information of the copy 
procedure. If the file being copied already exists, a new dialog will display asking the user 
whether or not the existing file should be replaced. The copy icon is dimmed when there 
are no selected files/folders to copy (for example, if no drive or domain is selected). It is 
also dimmed if the remote location cannot accept files copied to it (for example, Domain 
List/ Machine List). Copying a folder also copies everything within the folder. 

• Delete: Deletes the selected file(s)/folder(s). Deleting a folder will delete everything within 
the folder. 
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   Note Files deleted this way are fully removed from the original machine they were on. These files 
are not sent to the recycling bin and are in no way recoverable. 

Configuration Examples

The following configuration examples provide a demonstration of the usefulness and flexibility 
of the File Shares Applet.

• Configuring Bookmarks from Within the File Shares Applet, page 137

• Using Bookmarks from Within the File Shares Applet, page 140

• Moving Files and Folders, page 140

• Launching a File Directly from the File Shares Applet, page 141

Configuring Bookmarks from Within the File Shares Applet

Navigating a remote computer’s directory hierarchy structure takes a long time. To reduce this 
process as much as possible, the Dell SonicWALL SSL VPN File Shares Applet allows the user 
to create bookmarks on the fly from within the File Shares Applet itself. This allows the user to 
skip the hierarchy structure of the remote computer the next time she needs to access a 
particular file or folder.
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Step 1 Launch the File Shares Applet by clicking on the File Shares button in the Virtual Office portal. 
The File Shares Applet displays.

Step 2 The File Shares Applet’s default location for the local window is the base directory, while the 
remote window shows the entire network. Double-click the appropriate folders to navigate the 
local window to the desktop or another appropriate folder.

Step 3 To navigate the remote window, double-click a visible computer, or input the name in the 
address bar preceded by \\ and followed by a \ and press Enter. The File Shares Applet will 
then navigate to the requested computer. It may take several seconds for the resources to load, 
depending on the network configuration.

Step 4 Once loaded, double-click a folder or enter the target directory path within the address bar. This 
can take some time as the File Shares Applet must browse through the network after every 
change. 

    Note Only the remote window can use the address bar to navigate through a computer’s 
file hierarchy.

Step 5 To set a bookmark to the current directory, right-click in an empty location in the remote 
directory and select Add Bookmark. 
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    Note To set a bookmark for a specific file or folder, select it prior to selecting Add 
Bookmark from the right-click menu.

Step 6 Enter a name for the new bookmark in the New Bookmark window that displays. 

Step 7 Click OK. The bookmark is added to the Virtual Office portal. Clicking on the bookmark 
accesses the selected folder or file.
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Using Bookmarks from Within the File Shares Applet

In Addition to accessing bookmarks from the Virtual Office portal, bookmarks can be easily 
accessed from within the File Shares Applet.

Step 1 Launch the File Shares Applet by clicking on the File Shares button in the Virtual Office portal.

Step 2 Click the Bookmarks button on the task bar in the remote window. A pull down menu displays 
with the message Loading Bookmarks. Keep the mouse within the pull down menu as the File 
Shares Applet loads the bookmarks. 

Step 3 Once loaded, click book mark to load the desired file or folder.

Moving Files and Folders

The File Shares Applet is designed for ease of use. There is more than one way to perform file 
transfers.

This section provides an example of a folder that is copied from a remote machine onto the local 
machine’s desktop, deleted from the remote machine, and moved back from the local machine 
unto the remote machine, all from the File Shares Applet.

Step 1 Launch the File Shares Applet by clicking on a bookmark in the Virtual Office portal.

Step 2 Double-click the C:\ drive, double-click the Documents and Settings folder, then double-click 
a specific folder, for example, the one that holds the Desktop folder. 

Step 3 The current directory shows the Desktop folder. Select a file or folder from the remote machine 
and drag its icon onto the Desktop folder in the local machine. This will copy the item from the 
remote machine directly onto the desktop.

Step 4 Once the transfer is complete, double-click the Desktop folder. The folder copied from the 
remote machine will display in that folder. 

    Note The item still exists on the remote machine. To initiate a move, not a copy, you must 
use the Move command from the right-click menu.

Step 5 To delete the original file or folder, select it by clicking on it once, and press the Delete button 
on the tool bar. Alternatively, the item can be deleted by using the right-click menu. The File 
Shares Applet displays a delete confirmation window. Click the Delete button in the pop-up to 
delete the item.
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    Warning The File Shares Applet will completely delete the file or folder from the remote machine. In 

the case of a folder, nested items will also be deleted. These items will not be sent to the 

recycle bin on either machine and are not recoverable.

Step 6 Once the file or folder has been deleted, the File Shares Applet will automatically refresh, 
removing the item from the current directory. To copy it from the local machine back to the 
remote machine, click-and-drag like in Step 2, or use the Copy icon from the local machine’s 
tool bar. 

    Note The Copy icon in the toolbar automatically moves the selected file to whatever 
directory is currently open. To move an item to a different folder, either drag-and-
drop it into the desired destination or open the desired destination prior to clicking 
Copy.

Launching a File Directly from the File Shares Applet

Files can be launched from within the File Shares Applet. This section provides an example 
where a remote file is queried for its properties, bookmarked and opened.
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Step 1 Launch the File Shares Applet by clicking on a bookmark in the Virtual Office portal.

Step 2 Right click the file and select Properties.

The file’s properties will be displayed in a separate window.

Step 3 To open the file, double-click the file. Alternatively, create a bookmark to it, and launch the file 
from the bookmark menu. To create a bookmark, select the Add Bookmark option from the 
right-click menu. The name of the file is the default name of the new bookmark, but a new name 
can be entered if so desired.

Step 4 Then select the bookmark, either from the portal or from the bookmark tab in the toolbar.

    Note Files launched from within the File Shares Applet must be downloaded to the local 
machine before they can be opened. The File Shares Applet will store the file in a 
temporary directory while it is being used. The File Shares Applet will also try to 
delete the file after use, but may be unable to do so depending on whether or not 
another program is accessing it. Use caution when opening files with sensitive 
material.
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Using HTML-Based File Shares
File shares provide remote users with a secure Web interface to Microsoft File Shares using 
the CIFS (Common Internet File System) or SMB (Server Message Block) protocols. Using a 
Web interface similar in style to Microsoft’s familiar Network Neighborhood or My Network 
Places, File Shares allow users with appropriate permissions to browse network shares, 
rename, delete, retrieve, and upload files, and to create bookmarks for later recall.

   Note The server can be specified either by name or by IP address, for example, \\moosedc or 
\\10.50.165.2. For names to work, it is necessary that DNS and/or WINS be properly 
configured by the Administrator on the SRA appliance to be able to resolve host names.

To create a file share, perform the following steps:

Step 1 Click the File Shares button. Virtual Office displays a dialog box that provides a hot link to a 
login prompt.

    Note Pop-up window blockers may prevent File Shares from functioning properly. 
Configure your browser to allow pop-up windows on the SSL VPN portal site.

Step 2 To specify a new share path (as an example, \\moosedc) in the Address field. You need to 
precede the share name with two back slashes. For example: \\file-directory01.example.com.

Step 3 To connect to a pre-existing file share, click the Login to Server link next to the file share name.

Step 4 Click the go prompt to display the Enter Network Password dialog box.

Login 

Address 
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Step 5 Type a valid username in the User Name field and a valid password in the Password field and 
click Login.

Step 6 Virtual Office displays the home File Share screen that you have specified, displaying folders 
on the network to which you can navigate.
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The following table describes the controls at the top of the File Share window.

Step 7 You can now navigate the folders and files in the File Share as you would through Windows 
Explorer or other file management systems. 

Step 8 To add a new folder in the current File Share location, type the name of the folder in the Add 
New Folder: field and click Submit.

Step 9 To add a file in the current File Share location, click the Browse... button. Navigate to the 
location of the file on your computer in the Choose file window that opens, select the file and 
click OK, and then click Submit in the File Share window.

Table 1 File Share Controls

Button Description 

Back Navigate to the previous File Share location.

Forward Navigates forward to the previous File Share location after 
you have pressed the Back button.

Reload Reloads the current folder to display any changes.

Up Navigates 

Delete Deletes the selected folder or folders. Note that only empty 
folders can be deleted. If there are files in the folder, an error 
message is displayed. Delete all files out of the folder and 
then delete the folder.

Rename Renames the selected folders and files. Select items by 
checking the check box next to their name under the Select 
column.

Bookmark Creates a new bookmark to the current File Share location.

Logout Logout of the File Share service.
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Chapter 7

 Managing Bookmarks

Bookmarks are objects that enable you to connect to a location or application conveniently and 
quickly. The Virtual Office Bookmark system allows bookmarks to be created at the group and 
user levels. The Administrator can create both group and user bookmarks which will apply to 
applicable users while individual users can create only personal (user-level) bookmarks.

Since bookmarks are stored within the security appliance’s local configuration files, it is 
necessary for group and user bookmarks to be correlated to defined group and user entities. 
When working with local groups and users (LocalDomain), this is automated since the 
Administrator must manually define the groups and users on the device. Similarly, when 
working with external groups (not LocalDomain), the correlation is automated since creating an 
external domain creates a corresponding local group.

However, when working with external users, a local user entity must exist so that any user-
created (personal) bookmarks can be stored within the SRA appliance’s configuration files. The 
need to store bookmarks on the SRA appliance itself is because LDAP, RADIUS, and NT 
authentication external domains do not provide a direct facility to store such information as 
bookmarks.

Rather than requiring Administrators to manually create local users for external domain users 
wishing to use personal bookmarks, Dell SonicWALL SSL VPN automatically creates a 
corresponding local user entity when an external domain user logs in to the Virtual Office.

The following sections describe basic bookmark tasks:

• “Adding Bookmarks” section on page 148

• “Editing Bookmarks” section on page 156

• “Removing Bookmarks” section on page 156

• “Using Bookmarks” section on page 156
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Adding Bookmarks
Bookmarks provide a convenient way for you to access Web, FTP, or other services on the 
remote network that you will connect to frequently. To define bookmarks, perform the following:

Step 1 In the Virtual Office window at the top of the bookmarks table, click Show Edit Controls and 
then click Create a new bookmark. 

Step 2 In the Add Bookmark screen, enter a descriptive name in the Bookmark Name field.

Step 3 Enter the domain name, IP address, or IPv6 address of a host machine on the LAN in the Name 
or IP Address field. IPv6 addresses should be enclosed in brackets (i.e. the [ and ] symbols). 
You may also enter the wildcard variable %USERNAME% to display the current user name. 
Variables are case-sensitive.

Step 4 In the Description field, optionally enter a friendly description to be displayed in the bookmark 
table.

Step 5 Select the user permissions level from the Allow user to edit/delete drop-down list. You can 
select Use user policy, Allow, or Deny.
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Step 6 Select the service type in the Service drop-down list. You can select from the following 
services:

• Terminal Services (RDP - ActiveX)

• Terminal Services (RDP - Java)

• Terminal Services (RDP - HTML5)

• Terminal Services (Using Tunnel)

• Virtual Network Computing (VNC)

• Virtual Network Computing (VNC - HTML5)

• Citrix Portal (Citrix)

• Web (HTTP)

• Secure Web (HTTPS)

• External Web Site

• Mobile Connect

• File Shares (CIFS)

• File Transfer Protocol (FTP)

• Telnet

• Secure Shell version 1 (SSHv1)

• Secure Shell version 2 (SSHv2)

The following sections provide additional details about adding the different types of bookmarks:

• “Citrix Bookmarks” on page 149

• “RDP ActiveX, Java, and HTML5 Bookmarks” on page 151

• “Terminal Services (Using Tunnel)” section on page 154

• “Web Bookmarks” on page 155

• “FTP Bookmarks” on page 155

• “SSHv2 Bookmarks” on page 156

Once the configuration has been updated, the new bookmark will be displayed in the Virtual 
Office Bookmarks table. Click a bookmark description to go to the bookmark location that you 
have defined.

Citrix Bookmarks

For Citrix bookmarks, you can select the following options:

• The Dell SonicWALL SRA appliance will always perform the Citirix client detection when 
using Citrix Bookmarks. Click the Disable client detection by Citrix server check box to 
disable this feature wen using Citrix Bookmarks. Note that this feature is compatible with 
Citrix XenAPP 5.0 or later. 

• Designate that it be a secure Citrix connection by selecting the HTTPS Mode check box. 

• Select Always use Java in Internet Explorer to use Java to access the Citrix Portal when 
using Internet Explorer. Without this setting, a Citrix ActiveX client or plugin must be used 
with IE. This setting lets users avoid installing a Citrix client or plugin specifically for IE 
browsers. Java is used with Citrix by default on other browsers and also works with IE. 
Enabling this check box leverages this portability.
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• Select Always use specified Citrix ICA Server to explicitly specify the Citrix ICA Server 
Address for the Citrix ICA Session. By default, the Bookmark uses the information provided 
in the ICA configuration on the Citrix server.
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RDP ActiveX, Java, and HTML5 Bookmarks

ActiveX, Java, and HTML5 RDP bookmarks offer several features that are not available in other 
bookmarks.

  Tip The ActiveX client is only supported on the Internet Explorer browser, while the Java client 

is supported on all platforms and browsers that are compatible with Dell SonicWALL SSL 

VPN.
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Step 1 Enter the desired Bookmark Name.

Step 2 Enter the Name or IP Address of the resource you are trying to reach. You can also use an 
IPv6 address.

Step 3 In the Description field, type a brief description of the bookmark.

Step 4 In the Tabs field, create a comma-separate list of tabs showing where the bookmark should be 
displayed.

Step 5 Select Terminal Services (RDP - ActiveX) ,Terminal Services (RDP -Java), or Terminal 
Services (RDP - HTML5) from the Services list. Standard tabs (Desktop, Web, Files, Terminal, 
Mobile) do not need to be included.

Step 6 Continue to configure the RDP ActiveX, Java, or HTML5 Bookmark as follows:
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Option Usage

Screen Size Select the default screen size to be used when users execute 
this bookmark. It is advised that you select a size equal to or 
smaller than your current desktop screen size. ActiveX RDP 
bookmarks also have a full-screen option that will display the 
RDP window in full screen mode. To toggle from the RDP 
window back to your desktop, press Alt-Tab.

Colors Select the default color depth to be used when users execute 
this bookmark.

Application and Path To have the RDP session launch an application when the 
bookmark is initiated, enter the path to the application in the 
Application and Path (optional): field. For example, 
C:\Program Files\Example\app.exe (optional).

Command-line arguments Type any command-line arguments required to access the 
remote application.

Start in the following folder Enter the local folder to execute application commands in 
(optional).

Login as console/admin 
session

Check this option to enable console and admin commands on 
login.

Enable Wake on LAN Select this option to send WoL packets to the host. This 
option also allows entering one or more Mac/Ethernet 
Addresses (separated by spaces) for the machines to wake 
and the desired Wait time for boot-up before cancelling the 
WoL operation. To send the WoL packet to the hostname or 
IP of this bookmark, check the Send WOL packet to 
bookmark host Name or IP address check box, this option 
can be applied in tandem with a Mac address.

Server is TS Farm Check this option if users will connect to a TS Farm or load 
balanced server. You may need to disable interactive login for 
this option to work properly.

Redirects (ActiveX only) Optionally expand Show windows advanced options and 
select any of the redirect check boxes to redirect those 
devices or features on the local network for use in this 
bookmark session.

Redirects (Java only) Optionally expand Show windows advanced options and 
select any of the redirect check boxes, as well as any of the 
additional listed features for use in this bookmark session.

If the client application will actually be RDP 6 (Java), you can 
select any of the following options as well: Dual monitors, 
Span monitors, Font smoothing, Desktop composition, 
and Remote Application.

Automatically log in Check this option and select Use SSL VPN account 
credentials to forward credentials from the current SSL VPN 
session. Select Use custom credentials to enter a custom 
username, password, and domain for this bookmark. 

Display Bookmark to Mobile 
Connect clients

Check this option to display bookmarks to Mobile Connect 
clients running Mobile Connect 2.0 or higher. Some devices 
may require supported third-party applications for this feature 
to work properly.
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  Tip The ActiveX client is only supported on the Internet Explorer browser, while the Java client 

is supported on all platforms and browsers that are compatible with Dell SonicWALL SSL 

VPN.

Step 7 When you are finished. Click the Add button to add this bookmark to your Virtual Office list.

Determining the Remote Computer’s Full Name or IP Address

Complete the following steps to determine the full name of the computer to which the RDP 
bookmark is pointing:

Step 1 Right click the My Computer icon on the desktop of the remote computer, and select 
Properties.

Step 2 Click the Remote tab.

Step 3 The full computer name will be listed under Remote Desktop.

Complete the following steps to determine the IP address of your computer.

Step 1 In the Windows Start menu on the remote computer, navigate to Run...

Step 2 Type cmd to open the command interpreter and click OK.

Step 3 Type ipconfig. The IP address of your computer is displayed.

Configuring Remote Desktop Access on the Remote Computer

Complete the following steps to allow remote desktop access to the computer that is the target 
of the RDP bookmark:

Step 1 Right click the My Computer icon on the desktop, and select Properties.

Step 2 Click the Remote tab.

Step 3 Under Remote Desktop, select the check box for Allow users to connect remotely to this 
computer.

Step 4 Click OK.

Terminal Services (Using Tunnel)

The Terminal Services (Using Tunnel) Bookmark uses the NetExtender Client to tunnel RDP 
data, and does not need Browser Plug-ins to function. This bookmark should be used if your 
system is experiencing issues with RDP disconnect/reconnect that commonly occur when using 
the Windows 8 OS.

This bookmark works just like the existing RDP bookmarks, and the bookmark setting page is 
same as RDP ActiveX/Java bookmark. All the advanced options are exactly same, but this 
bookmark starts the NetExtender Client first before launching the native RDC client. So this 
bookmark needs the NetExtender connection allowed to the portal.
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This bookmark would start the NetExtender connection if it’s not connected, and add host route 
to the NetExtender adapter. If the NetExtender connection is done by this RDP bookmark, after 
the RDP connection is closed, it need to be auto disconnect the NetExtender connection.

Web Bookmarks

For HTTP(S) bookmarks, you can select Use SSL-VPN account credentials to log in or 
configure custom credentials for use with Single Sign-On. To disable the use of SSO, clear the 
Automatically log in check box. Select the Forms-based Authentication check box to use this 
method, and then fill in the following fields that are exposed:

• Configure the User Form Field to be the same as the ‘name’ or ‘id’ attribute of the HTML 
element representing User Name in the Login form, for example:
<input type=text name=’userid’>

• Configure the Password Form Field to be the same as the ‘name’ or ‘id’ attribute of the 
HTML element representing Password in the Login form, for example:
<input type=password name=’PASSWORD’ id=’PASSWORD’ maxlength=128>

For External Web Site bookmarks, select HTTPS Mode to encrypt Web communication with 
SSL. External Web Site bookmarks are used to access an offloaded Web site or portal using a 
bookmark. Select Disable security warning if you do not want a security warning dialog box 
to be displayed when a user clicks this bookmark. If left unchecked, the warning dialog will allow 
the user to select a “Do not show this warning again” option if the user has permissions to edit 
this bookmark (set above).

For more information about offloaded applications, see the Application Offloading section in the 
Dell SonicWALL SSL VPN Administrator Guide.

FTP Bookmarks

For FTP bookmarks, click Show advance server configuration to select the character 
encoding. You can also select Use SSL-VPN account credentials to log in or configure 
custom credentials for use with Single Sign-On. To disable the use of SSO, clear the 
Automatically log in check box.

Mobile Connect Bookmarks

The Mobile Connect bookmark allows a custom bookmark to be defined for display in Mobile 
Connect after the user is connected. This bookmark is meant to support any third-party app, 
whether an in-house app or a public app in the App Store or Google Play. The bookmark also 
enables calling third-party apps that have defined a custom URL scheme, for example 
‘comgoogleearth://’ for Google Earth. The Mobile Connect bookmark is only available for edit 
from normal browsers and is intended for use only on mobile devices. 

   Note The Mobile Connect bookmark may also be used for ‘http://’ or ‘https://’ URL schemes, 
however, Dell SonicWALL recommends using HTTP or HTTPS bookmarks for these 
schemes. 
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SSHv2 Bookmarks

For SSHv2 bookmarks, you must have SUN JRE 1.6.0_10 or higher and must be connecting 
to a server that supports SSHv2. There are also options to Automatically accept host key and 
to Bypass username. The bypass option should only be used for SSHv2 servers that do not 
require authentication in the initial connection session (such as Dell SonicWALL security 
appliances).

Editing Bookmarks
You can change the IP address, domain name, or IPv6 address as well as the service and other 
settings associated with an existing bookmark. 

   Note Only user-created Bookmarks can be edited or deleted by the user. Global or Group 
Bookmarks pre-defined by the Administrator cannot be edited or deleted.

To edit a bookmark to change its name or associated IP address, perform the following steps:

Step 1 Identify a bookmark in the Virtual Office Bookmarks list for which you want to change an IP 
address or domain name or other settings.

Step 2 In the Virtual Office Bookmarks list, click the Configure icon for an existing bookmark. The Edit 
Bookmark dialog box displays.

Step 3 To change the bookmark name, domain name or IP address of the bookmark, edit the names 
in the Bookmark Name or Name or IP Address fields.

Step 4 To change the service, select a new Service from the drop-down menu.

Step 5 Optionally change other settings specific to the Service type.

Step 6 Optionally enable or disable the Automatically log in setting, or change the credentials 
selection.

Step 7 Click Apply. The Virtual Office home page displays with the new IP address or domain name.

Removing Bookmarks
To remove a bookmark, perform the following steps:

Step 1 Identify a bookmark in the Virtual Office Bookmarks list that you want to remove.

Step 2 In the Virtual Office Bookmarks list, click the delete icon  for the bookmark you want to 
remove. The bookmark disappears from the list.

Using Bookmarks
The following sections describe how to use the various types of bookmarks:

• “Using Remote Desktop Bookmarks” section on page 157

• “Using VNC Bookmarks” section on page 160
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• “Using FTP Bookmarks” section on page 162

• “Using Telnet Bookmarks” section on page 166

• “Using SSHv1 Bookmarks” section on page 166

• “Using SSHv2 Bookmarks” section on page 167

• “Using Mobile Connect Bookmarks” section on page 169

• “Mobile Connect Bookmarks” section on page 155

• “Using File Share Bookmarks” section on page 170

• “Using Citrix Bookmarks” section on page 170

• “Global Bookmark Single Sign-On Options” section on page 176

• “Per-Bookmark Single Sign-On Options” section on page 176

Using Remote Desktop Bookmarks

Remote Desktop Protocol (RDP) bookmarks enable you to establish remote connections with 
a specified desktop. Dell SonicWALL SSL VPN supports the RDP5 standard with Java, ActiveX, 
and HTML5 clients. RDP5 ActiveX can only be used through Internet Explorer, while RDP5 
Java can be run on any platform and browser supported by the Dell SonicWALL SSL VPN. The 
basic functionality of the two clients is the same; however, the Java client is a native RDP client 
and supports the following features that the ActiveX client does not:

• Redirect Printers

• Redirect Ports

• Redirect Drives

• Redirect SmartCards

• Redirect clipboard

• Redirect plug and play devices

• Display connection bar

• Auto reconnection

• Desktop background

• Bitmap caching

• Menu/window animation

• Visual styles

• Window drag

If the Java client application is RDP 6, it also supports:

• Dual monitors

• Span monitors

• Font smoothing

• Desktop composition

• Remote Application

The Dell SonicWALL SSL VPN also supports the Terminal Services (Using Tunnel) bookmark, 
which uses the NetExtender Client to tunnel RDP data, and does not need Browser Plug-ins to 
function. This bookmark should be used if your system is experiencing issues with RDP 
disconnect/reconnect that commonly occur when using the Windows 8 OS.

This bookmark works just like the existing RDP bookmarks, and the bookmark setting page is 
same as RDP ActiveX/Java bookmark. All the advanced options are exactly same, but this 
bookmark starts the NetExtender Client first before launching the native RDC client. So this 
bookmark needs the NetExtender connection allowed to the portal.
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This bookmark would start the NetExtender connection if it’s not connected, and add host route 
to the NetExtender adapter. If the NetExtender connection is done by this RDP bookmark, after 
the RDP connection is closed, it need to be auto disconnect the NetExtender connection.

   Note RDP bookmarks can use a port designation if the service is not running on the default port.

  Tip To terminate your remote desktop session, be sure to log off from the Terminal Server 

session. If you wish to suspend the Terminal Server session (so that it can be resumed later) 

you may simply close the remote desktop window.

Step 1 Click the RDP bookmark. Continue through any warning screens that display by clicking Yes or 
Ok. 
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Step 2 Enter your username and password at the login screen and select the proper domain name 
from the drop-down menu.

Step 3 A window is displayed indicating that the Remote Desktop Client is loading. The remote 
desktop then loads in its own windows. You can now access all of the applications and files on 
the remote computer.

For information on configuring options for RDP bookmarks, see “RDP ActiveX, Java, and 
HTML5 Bookmarks” on page 151.
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Using VNC Bookmarks

Step 1 Click the VNC bookmark. The following window is displayed while the VNC client is loading.

    Note VNC can have a port designation if the service is running on a different port.

Step 2 When the VNC client has loaded, you will be prompted to enter your password in the VNC 
Authentication window.

Step 3 To configure VNC options, click the Options button. The Options window is displayed.
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The following table describes the options that can be configured for VNC.

Table 1 VNC Options

Option Default Description of Options

Encoding Tight Hextile is a good choice for fast networks, while Tight is 
better suited for low-bandwidth connections. From the other 
side, the Tight decoder in TightVNC Java viewer is more 
efficient than Hextile decoder so this default setting can 
also be acceptable for fast networks.

Compression Level Default Use specified compression level for Tight and Zlib 
encodings. Level 1 uses minimum of CPU time on the server 
but achieves weak compression ratios. Level 9 offers best 
compression but may be slow in terms of CPU time 
consumption on the server side. Use high levels with very 
slow network connections, and low levels when working 
over higher-speed networks. The Default value means that 
the server's default compression level should be used.

JPEG image quality 6 This cannot be modified.

Cursor shape updates Enable Cursor shape updates is a protocol extension used to 
handle remote cursor movements locally on the client side, 
saving bandwidth and eliminating delays in mouse pointer 
movement. Note that current implementation of cursor 
shape updates does not allow a client to track mouse cursor 
position at the server side. This means that clients would not 
see mouse cursor movements if the mouse was moved 
either locally on the server, or by another remote VNC client. 

Set this parameter to Disable if you always want to see real 
cursor position on the remote side. Setting this option to 
Ignore is similar to Enable but the remote cursor will not be 
visible at all. This can be a reasonable setting if you don't 
care about cursor shape and don't want to see two mouse 
cursors, one above another.

Use CopyRect Yes CopyRect saves bandwidth and drawing time when parts of 
the remote screen are moving around. Most likely, you don't 
want to change this setting.

Restricted colors No If set to No, then 24-bit color format is used to represent 
pixel data. If set to Yes, then only 8 bits are used to 
represent each pixel. 8-bit color format can save bandwidth, 
but colors may look very inaccurate.

Mouse buttons 2 and 
3

Normal If set to Reversed, the right mouse button (button 2) will act 
as if it was the middle mouse button (button 3), and vice 
versa.

View only No If set to Yes, then all keyboard and mouse events in the 
desktop window will be silently ignored and will not be 
passed to the remote side.

Share desktop Yes If set to Yes, then the desktop can be shared between 
clients. If this option is set to No then an existing user 
session will end when a new user accesses the desktop.
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 The following table describes the options that can be configured for VNC - HTML5:

Table 2 VNC-HTML5 Options

Using FTP Bookmarks

FTP bookmarks can use a port designation if the service is not running on the default port.

Option Description

View Only Select the View Only check box to disable keyboard and mouse events in the 
desktop window.

Share Desktop Select the Share Desktop check to enable desktop sharing between clients.

Display Bookmark to 
Mobile Connect clients

Select the Display Bookmark to Mobile Connect clients check box to enable 
bookmark viewing on Mobile Connect clients. Mobile Connect must be running ver-
sion 2.0 or newer to view and access this bookmark. 
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Step 1 Click the FTP bookmark. The FTP Session dialog box displays.

Step 2 Enter your username and password. If you want to use your Virtual Office username and 
password, simply leave the fields blank.

Step 3 Click Submit. An FTP session displays.
.

Step 4 You can use the following utilities in the FTP site:

– To manually navigate to a folder, enter the folder name in the Go to directory field and 
click Submit.

– To create new folders in the directory, use the Create new folder fields. 

Go to 
directory 
Utility

Create new 
folder Utility

Delete 
Marked 

Rename 
Utility
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– To delete multiple files, click in the check boxes of files or folders you want to remove 
and click Delete Marked. 

– To rename a file or folder, click in the check box of a file or a folder and click Rename.

Step 5 To initiate another FTP session, click the Add New Session button. To return to the initial FTP 
session, click the link for it (in the form username@ipaddress) under the Add New Session 
button.

Downloading Files

To download a file, perform the following:

Step 1 Click Download Files in the navigation bar. 

Step 2 Click the name of the file in the Filename column. The File Download window displays.

Step 3 Click Run to launch the file. Click Save to save it to your computer.
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Uploading Files

To upload a file, perform the following:

Step 1 Click Upload Files in the navigation bar. The Upload FTP Files window will be displayed. 

Step 2 The current directory is displayed in the Upload files to: field. To navigate to a different 
directory, enter the directory name in the Go to directory: field. To create a new folder in the 
current directory, enter the name of the folder in the Create new folder: field and click submit.

Step 3 Select the file you want to upload by clicking the Browse... button and navigating to the file. 
You can upload up to three files at once.

To navigate between uploads, click the Sessions link.

Step 4 Click Upload to upload the files.
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Using Telnet Bookmarks

Step 1 Click the Telnet bookmark. 

Telnet bookmarks can use a port designation for servers not running on the default port.

Step 2 Click OK to any warning messages that are displayed. A Java-based Telnet window launches.

Step 3 If the device you are Telnetting to is configured for authentication, enter your username and 
password.

Using SSHv1 Bookmarks

SSH bookmarks can use a port designation for servers not running on the default port.

Step 1 Click the SSHv1 bookmark. A Java-based SSH window is launched.

Step 2 Enter your username and password.

Step 3 A SSH session is launched in the Java applet.

  Tip Some versions of the JRE may cause the SSH authentication window to pop up behind the 

SSH window.
166 | SRA 7.5 User Guide



Using SSHv2 Bookmarks

SSH bookmarks can use a port designation for servers not running on the default port.
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Step 1 Click the SSHv2 bookmark. A Java-based SSH window displays. Type your user name in the 
Username field and click Login.

Step 2 A hostkey popup displays. Click Yes to accept and proceed with the login process.

Step 3 Enter your password and click OK.

Step 4 The SSH terminal launches in a new screen.
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Using Mobile Connect Bookmarks

Step 1 Click the Mobile Connect bookmark.

Step 2 Enter the Bookmark Name and the Name or IP Address. The Name or IP Address field is the 
custom URL scheme.

Step 3 Enable the Display Bookmark to Mobile Connect clients check box to send bookmark 
information to Mobile Connect clients. Click OK.

Once the Mobile Connect bookmark on the SRA is successfully configured, the bookmark will 
display on your mobile device:
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Using Web Bookmarks

Step 1 Click the HTTP or HTTPS bookmark.

    Note HTTP bookmarks can have a port designation and a path.

Step 2 A new window is launched in your default browser that connects to the domain name or IP 
address specified in the bookmark.

HTTP & HTTPS Bookmarks have been tested and verified to support the following web 
applications:

• Microsoft Outlook Web Access 2010, Outlook Web Access 2007, and Outlook Web Access 
2003.

• Windows Sharepoint 2007, Windows Sharepoint Services 3.0 and Windows Sharepoint 
Services 2.0.

• Please note the client integrated features of Sharepoint are not supported.

• Lotus Domino Web Access 7.0

• Novell Groupwise Web Access 7.0 

Other applications may work but there may be problems accessing pages that are malformed, 
have advanced HTML features, use an unsupported authentication method (for example, 
Windows Integrated Authentication) and URLs that are embedded in Macromedia Flash, Java 
or ActiveX. If a web application does not work with a HTTP or HTTPS Bookmark, contact your 
Administrator. 

Using File Share Bookmarks

For information on using File Share bookmarks, see the “Using HTML-Based File Shares” 
section on page 143.

Using Citrix Bookmarks

Citrix is a remote access, application sharing service, similar to RDP. It enables users to 
remotely access files and applications on a central computer over a secure connection. There 
are two types of Citrix bookmarks:

• “ActiveX Citrix Bookmark” on page 171

• “Java Citrix Bookmark” on page 174
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ActiveX Citrix Bookmark

When using the Internet Explorer web browser, Citrix bookmarks launch the ActiveX Citrix 
client. The following steps describe how to launch and use the ActiveX Citrix client.

Step 1 Click the Citrix bookmark. The first time you use a Citrix bookmark, it will install the Citrix Web 
Client on your computer if you do not already have it. 

Step 2 Click Install to install the client.

Step 3 The Citrix Web Client begins to install. If prompted, click the banner to grant ActiveX control to 
the Citrix Web Client.

Step 4 Click Yes to the Security Warning message that is displayed.
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Step 5 The Citrix Web Client installs.

Step 6 Click Yes to the Citrix license agreement.

Step 7 When the Citrix Web Client has installed, click OK If the Citrix Web Interface login window does 
not display, restart your Web browser and launch the Citrix bookmark again.
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Step 8 Enter your username, password, and domain in the Citrix Web Interface login window.

Step 9 The Citrix Web Interface home page is displayed. Click the application you want to use.

Step 10 You may be prompted to install additional Citrix software.

Step 11 The shared application is now launched.
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Java Citrix Bookmark

When using a non-Internet Explorer web browser, Citrix bookmarks launch the Java Citrix 
client. The following steps describe how to launch and use the Java Citrix client.

Step 1 Click the Citrix bookmark. The login window displays.

Step 2 For Logon type, select either Anonymous or Explicit. Select Anonymous to login without 
providing a user name. Note that you may not be able to access resources that require 
authentication. Select Explicit to login with a user name and password. You may also be 
required to provide a domain name or NDS context.

Step 3 Click the Log On button. The Citrix Java applet displays. The default applications will display 
in the Applications section in the middle of the window. 

Step 4 Click Messages to view any Citrix messages you have received.

Step 5 Click Preferences to customize the Citrix Java applet settings.

Step 6 Select Display Settings to change the language and to specify if Citrix hints should be 
displayed.
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Step 7 Select Session Settings to customize the default window size for Citrix sessions.

Step 8 In the Window Size drop-down menu, select one of the following options:

• No preference: Uses the default setting configured by your Administrator.

• Full screen: Resources are maximized to fill your screen.

• Seamless: Resources that support resizing appear in resizable windows.

• Custom dimensions: Enables you to specify the width and height of the resource window 
in pixels.

• Percentage of screen: Enables you to specify the percentage of your screen the resources 
will occupy.

Step 9 Select Account Settings to configure the behavior of your sessions when you log out. 

Step 10 Select the Log off all sessions check box to shut down all of your active resources when you 
log off from the Citrix session. If you disable this check box, any active resources that are 
hosted on a remote server continue to run when you log off. (Offline applications always 
continue to run when you log off from the Citrix session.)
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Global Bookmark Single Sign-On Options

You can configure single sign-on using the Options button on the main Virtual Office page. 
SSO settings will be enabled only if the Administrator has configured user- controlled single 
sign-on (SSO). To configure SSO bookmark options, perform the following tasks:

Step 1 Click the Options button at the top right of the Virtual Office. The User Options page displays.

Step 2 Under Single Sign-On Settings, select Use SSL VPN account credentials to log into 
bookmarks to enable SSO for bookmarks. Leave the box unchecked if you do not want to use 
SSO for bookmarks.

Step 3 Click Save to save your changes.

Fileshares will use the configured domain name of which the user is a member to supply to the 
backend server. HTTP, HTTPS, FTP, RDP - ActiveX, RDP- Java will supply the username and 
password that was used to login. If the server is expecting a domain-prefixed username, SSO 
will fail. In some cases, a default domain can be specified at the server to allow SSO to 
succeed.

Per-Bookmark Single Sign-On Options

Dell SonicWALL SSL VPN supports per-bookmark single sign-on for the following bookmark 
services:

• Terminal Services (RDP - Active X)

• Terminal Services (RDP - Java)

• Web (HTTP)

• Secure Web (HTTPS)

• File Shares (CIFS)

• File Transfer Protocol (FTP)
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Per-Bookmark SSO allows users to enable or disable SSO for individual bookmarks. This 
flexibility in specifying login credentials is useful in the following cases:

• Users who use multiple accounts to access a variety of resources.

• Users who use two-factor authentication to log in to the SSL VPN Virtual Office, but use a 
static password to access other resources.

• Users who need to access servers that require a domain prefix.

To configure per-bookmark SSO, perform the following tasks.

Step 1 Before enabling SSO on an individual bookmark, you must first enable SSO globally as 
described in the “Global Bookmark Single Sign-On Options” section on page 176.

Step 2 On the Virtual Office page, click the Create a new bookmark button.

Step 3 Select one of the service types that supports per-bookmark SSO: Terminal Services (RDP - 
Active X), Terminal Services (RDP - Java), Web (HTTP), Secure Web (HTTPS), File Shares 
(CIFS), or File Transfer Protocol (FTP).

Step 4 To disable SSO for the bookmark, clear the Automatically log in check box. 

Step 5 To use SSO for the bookmark, select the Automatically log in check box and then select one 
of the following radio buttons:

• Use SSL-VPN account credentials – allow login to the bookmark using the local user 
credentials configured on the SRA appliance

• Use custom credentials – allow login to the bookmark using the credentials you enter 
here; when selected, this option displays Username, Password, and Domain fields. Enter 
the custom credentials into the Username, Password, and Domain fields that are 
displayed.

You can enter the custom credentials as text or use dynamic variables such as those shown 
below: 

Step 6 For Web (HTTP) and Secure Web (HTTPS) bookmarks, select the Forms-based 
Authentication check box to use this method for SSO, and then fill in the following fields that 
are exposed:

• Configure the User Form Field to be the same as the ‘name’ or ‘id’ attribute of the HTML 
element representing User Name in the Login form, for example:
<input type=text name=’userid’>

Text Usage Variable Example Usage

Login Name %USERNAME% US\%USERNAME%

Domain Name %USERDOMAIN% %USERDOMAIN\%USERNAME%

Group Name %USERGROUP% %USERGROUP%\%USERNAME%

Password %PASSWORD% %PASSWORD% or leave the field blank
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• Configure the Password Form Field to be the same as the ‘name’ or ‘id’ attribute of the 
HTML element representing Password in the Login form, for example:
<input type=password name=’PASSWORD’ id=’PASSWORD’ maxlength=128>

Step 7 Click OK.

Step 8 Enter the User name and password for the service.
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Appendix A

Support Information

This appendix contains the following sections:

• “Contact Information” on page 179

• “GNU General Public License (GPL) Source Code” on page 179

• “Limited Hardware Warranty” on page 179

• “End User Licensing Agreement” on page 180

Contact Information
For timely resolution of technical support questions, visit Dell SonicWALL on the Internet at 
<http://www.sonicwall.com/us/support.html>. Web-based resources are available to help you 
resolve most technical issues or contact Dell SonicWALL Technical Support

Technical Support Contact Information:
Contact Support Page - http://www.sonicwall.com/us/support/contact.html
Contact SonicWALL Page - http://www.sonicwall.com/us/company/286.html

GNU General Public License (GPL) Source Code
Dell SonicWALL will provide a machine-readable copy of the GPL open source on a CD. To 
obtain a complete machine-readable copy, send your written request, along with a certified 
check or money order in the amount of US $25.00 payable to "Dell SonicWALL, Inc." to: 

 General Public License Source Code Request 
 Dell SonicWALL, Inc. Attn: Jennifer Anderson
 2001 Logic Drive
 San Jose, CA 95124-3452

Limited Hardware Warranty
All Dell SonicWALL appliances come with a 1-year Limited Hardware Warranty which provides 
delivery of critical replacement parts for defective parts under warranty.  In addition, for 90 days 
from the warranty start date, Dell SonicWALL SRA 4600/1600 appliances are entitled to a 
Limited Software Warranty which provides bug fixes, updates and any maintenance releases 
that occur during the coverage term.  Visit the Warranty Information page for details on your 
product’s warranty:
http://www.sonicwall.com/us/support/Services.html#tab=warranty

Dell SonicWALL, Inc. warrants that commencing from the delivery date to Customer (but in any 
case commencing not more than ninety (90) days after the original shipment by Dell 
SonicWALL), and continuing for a period of twelve (12) months, that the product will be free 
from defects in materials and workmanship under normal use. This Limited Warranty is not 
transferable and applies only to the original end user of the product. Dell SonicWALL and its 
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suppliers' entire liability and Customer's sole and exclusive remedy under this limited warranty 
will be shipment of a replacement product. At Dell SonicWALL's discretion the replacement 
product may be of equal or greater functionality and may be of either new or like-new quality. 
Dell SonicWALL's obligations under this warranty are contingent upon the return of the 
defective product according to the terms of Dell SonicWALL's then-current Support Services 
policies. 

This warranty does not apply if the product has been subjected to abnormal electrical stress, 
damaged by accident, abuse, misuse or misapplication, or has been modified without the 
written permission of Dell SonicWALL. 

DISCLAIMER OF WARRANTY. EXCEPT AS SPECIFIED IN THIS WARRANTY, ALL 
EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS, AND WARRANTIES 
INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTY OR CONDITION OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT, 
SATISFACTORY QUALITY OR ARISING FROM A COURSE OF DEALING, LAW, USAGE, OR 
TRADE PRACTICE, ARE HEREBY EXCLUDED TO THE MAXIMUM EXTENT ALLOWED BY 
APPLICABLE LAW. TO THE EXTENT AN IMPLIED WARRANTY CANNOT BE EXCLUDED, 
SUCH WARRANTY IS LIMITED IN DURATION TO THE WARRANTY PERIOD. BECAUSE 
SOME STATES OR JURISDICTIONS DO NOT ALLOW LIMITATIONS ON HOW LONG AN 
IMPLIED WARRANTY LASTS, THE ABOVE LIMITATION MAY NOT APPLY TO YOU. THIS 
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER 
RIGHTS WHICH VARY FROM JURISDICTION TO JURISDICTION. This disclaimer and 
exclusion shall apply even if the express warranty set forth above fails of its essential purpose.

DISCLAIMER OF LIABILITY. DELL SONICWALL'S SOLE LIABILITY IS THE SHIPMENT OF A 
REPLACEMENT PRODUCT AS DESCRIBED IN THE ABOVE LIMITED WARRANTY. IN NO EVENT 
SHALL DELL SONICWALL OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES WHATSOEVER, 
INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, BUSINESS 
INTERRUPTION, LOSS OF INFORMATION, OR OTHER PECUNIARY LOSS ARISING OUT OF THE USE 
OR INABILITY TO USE THE PRODUCT, OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, 
INCIDENTAL, OR PUNITIVE DAMAGES HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF 
LIABILITY ARISING OUT OF THE USE OF OR INABILITY TO USE HARDWARE OR SOFTWARE EVEN 
IF DELL SONICWALL OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. In no event shall Dell SonicWALL or its suppliers' liability to Customer, whether in 
contract, tort (including negligence), or otherwise, exceed the price paid by Customer. The 
foregoing limitations shall apply even if the above-stated warranty fails of its essential 
purpose. BECAUSE SOME STATES OR JURISDICTIONS DO NOT ALLOW LIMITATION OR 
EXCLUSION OF CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT 
APPLY TO YOU.

End User Licensing Agreement
PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THE SONICWALL 
PRODUCT. BY INSTALLING OR USING THE SONICWALL PRODUCT, YOU (AS THE 
CUSTOMER, OR IF NOT THE CUSTOMER, AS A REPRESENTATIVE/AGENT AUTHORIZED 
TO BIND THE CUSTOMER) INDICATE ACCEPTANCE OF AND AGREE TO THE TERMS AND 
CONDITIONS OF THIS AGREEMENT FOR AND ON BEHALF OF THE CUSTOMER. IF YOU 
DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, THEN DO NOT 
USE THE PRODUCT AND RETURN IT TO THE PLACE OF PURCHASE WITH PROOF OF 
PURCHASE WITHIN THIRTY (30) DAYS OF PURCHASE FOR A REFUND. IF YOU DO 
PROCEED TO INSTALL OR USE THE SONICWALL PRODUCT, YOU WILL HAVE INDICATED 
ACCEPTANCE AND AGREEMENT WITH THE TERMS AND CONDITIONS HEREIN. 
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NOTWITHSTANDING THE FOREGOING, THIS AGREEMENT SHALL NOT SUPERSEDE ANY 
OTHER SIGNED AGREEMENT BETWEEN YOU AND SONICWALL THAT EXPRESSLY 
GOVERNS THE SONICWALL PRODUCT.

"Product" means the SonicWALL labeled hardware and related documentation ("Hardware") 
and/or proprietary SonicWALL labeled software, firmware and related documentation 
("Software") purchased by the end user of the product either directly from SonicWALL or a 
Reseller (“Customer”). “Services” means the Support Services described below and any other 
services provided with or for the Products directly by SonicWALL or its agents. “Reseller” shall 
mean those entities to which SonicWALL or SonicWALL’s authorized distributors distribute the 
Products for resale to end users. Except as otherwise agreed upon by the parties, this 
Agreement will also cover any updates and upgrades to the Products provided to Customer by 
SonicWALL directly or through a Reseller (except as may be otherwise indicated, such updates 
and upgrades shall be deemed Products).

1. LICENSE(S) AND RESTRICTIONS

(a) Licenses. Subject to the terms and conditions of this Agreement, SonicWALL grants to 
Customer, and Customer accepts from SonicWALL, a nonexclusive, nontransferable (except as 
otherwise set forth herein) and nonsublicensable license (“License”) to:

(i) execute and use the Software on the Hardware with which the Software is provided (pre-
installed) in accordance with the applicable Documentation; and,

(ii) for Software provided in standalone form (without Hardware), install, execute and use 
the Software on the Hardware or hardware device(s) on which it is intended to be used in 
accordance with the applicable Documentation and the License purchased. If Customer 
purchased multiple copies of standalone Software, Customer’s License to such standalone 
Software includes the right to install, use and execute up to the number of copies of 
Software Licenses purchased.

In addition, the License includes the right to (x) make a reasonable number of additional copies 
of the Software to be used solely for non-productive archival purposes, and (y) make and use 
copies of the end user documentation for Hardware and/or Software provided with the Products 
(“Documentation”) as reasonably necessary to support Customer’s authorized users in their 
use of the Products.

(b) License Limitations. Order acknowledgments, Documentation and/or the particular type of 
the Products/ Licenses purchased by Customer may specify limits on Customer’s use of the 
Software, and which limits apply to the License(s) granted hereunder for such Software. Such 
limits may consist of limiting the term of the License, or the number or amount of nodes, storage 
space, sessions, calls, users, subscribers, clusters, devices, ports, bandwidth, throughput or 
other elements, and/or require the purchase of separate Licenses to use or obtain particular 
features, functionalities, services, applications or other items. Use of the Software shall be 
subject to all such limitations.

(c) For Customer’s Internal Business. Each License shall be used by Customer solely to 
manage its own internal business operations as well as the business operations of its Affiliates. 
Notwithstanding the foregoing, if Customer is in the regular business of providing firewall, VPN 
or Security management for a fee to entities that are not its Affiliates (“MSP Customers”), 
Customer may use the Products for its MSP Customers provided that either (i) Customer, and 
not MSP Customers, maintain control and possession of the Products, or (ii) if MSP Customers 
have possession and/or control of Products in whole or in part, this Agreement must be 
provided to MSP Customers and they must agree that their use of the Products is subject to the 
terms and conditions of this Agreement. Customer agrees to indemnify and hold SonicWALL 
harmless from and against any claims by MSP Customers against SonicWALL relating to the 
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Products and/or Customer’s services for MSP Customers. “Affiliate” means any legal entity 
controlling, controlled by, or under common control with a party to this Agreement, but only for 
so long as such control relationship exists.

(d) Evaluation License. If the Software is provided by SonicWALL or a Reseller at no charge for 
evaluation purposes, then Section 1(a) above shall not apply to such Software and instead 
Customer is granted a nonproduction License to use such Software and the associated 
documentation solely for Customer’s own internal evaluation purposes for an evaluation period 
of up to thirty (30) days from the date of delivery of the Software, plus any extensions granted 
by SonicWALL in writing (the "Evaluation Period"). There is no fee for Customer’s use of the 
Software for nonproduction evaluation purposes during the Evaluation Period, however, 
Customer is responsible for any applicable shipping charges or taxes which may be incurred, 
and any fees which may be associated with usage beyond the scope permitted herein. 
Notwithstanding anything otherwise set forth in this Agreement, Customer understands and 
agrees that evaluation Software is provided “AS IS” and that SonicWALL does not provide a 
warranty or maintenance services for evaluation Licenses.

(e) Restrictions. Customer may not (i) modify, translate, localize, adapt, rent, lease, loan, create 
or prepare derivative works of, or create a patent based on the Software or any part thereof, (ii) 
make copies except as expressly authorized under this Agreement, (iii) copy the Software onto 
any public or distributed network, (iv) modify or resell the Software, use the Software in 
connection with the operation of any nuclear facilities, or use for purposes which are 
competitive to SonicWALL, or (v) except as expressly authorized in Section 2(c) above, operate 
the Software for use in any time-sharing, outsourcing, service bureau or application service 
provider type environment. Unless and except to the extent authorized in the applicable 
Documentation, Software provided with and/or as the Product, in part or whole, is licensed for 
use only in accordance with the Documentation as part of the Product: Software components 
making up a Product may not be separated from, nor used on a separate or standalone basis 
from the Product. Each permitted copy of the Software and Documentation made by Customer 
hereunder must contain all titles, trademarks, copyrights and restricted rights notices as in the 
original. Customer understands and agrees that the Products may work in conjunction with third 
party products and Customer agrees to be responsible for ensuring that it is properly licensed 
to use such third party products. Any Software provided in object code form is licensed 
hereunder only in object code form. Except to the extent allowed by applicable law if located in 
the European Union, and then only with prior written notice to SonicWALL, Customer shall not 
disassemble or reverse engineer the Software in whole or in part or authorize others to do so. 
Customer agrees not to use the Software to perform comparisons or other "benchmarking" 
activities, either alone or in connection with any other software or service, without SonicWALL’s 
written permission; or publish any such performance information or comparisons.

(f) Third Party Software. There may be certain third party owned software provided along with, 
or incorporated within, the Products (“Third Party Software”). Except as set forth below, such 
Third Party Software shall be considered Software governed by the terms and conditions of this 
Agreement. However, some Products may contain other Third Party Software that is provided 
with a separate license agreement, in which case such Third Party Software will be governed 
exclusively by such separate license agreement ("Third Party License") and not this 
Agreement. Any such Third Party Software that is governed by a Third Party License, and not 
this Agreement, will be identified on the applicable Product page on SonicWALL’s website and/
or in a file provided with the Product. Except as SonicWALL may otherwise inform Customer in 
writing, the Third Party License gives Customer at least the license rights granted above, and 
may provide additional license rights as to the Third Party Software, but only with respect to the 
particular Third Party Software to which the Third Party License applies. SUCH THIRD PARTY 
SOFTWARE UNDER A THIRD PARTY LICENSE IS PROVIDED WITHOUT ANY WARRANTY 
FROM SONICWALL AND ITS SUPPLIERS, INCLUDING BUT NOT LIMITED TO 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NON-INFRINGEMENT. Notwithstanding the foregoing, SonicWALL shall honor its warranty, 
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maintenance and support obligations in respect to the SonicWALL Products regardless of 
whether the warranty, maintenance or support issue is caused in whole or in part by the Third 
Party Software provided by SonicWALL with the Product.

(g) Updates/Upgrades. If Customer purchases or otherwise is eligible to receive a SOFTWARE 
update or upgrade, you must be properly licensed to use the Product identified by SonicWALL 
as being eligible for the update/ upgrade in order to install and use the SOFTWARE update/ 
upgrade. A SOFTWARE update/ upgrade replaces and/or supplements the Software Product 
that formed the basis for your eligibility for the update/upgrade, and does not provide you an 
additional License (copy) of the Software to use separately from the Software Product to be 
updated/ upgraded. You may use the resulting updated/upgraded Product only in accordance 
with the terms of this Agreement.

(h) Activation Keys May Expire. Certain Products, including Security Services that provide 
regular ongoing updates for Software (e.g., Security Service consisting of anti-virus signature 
updates), may come with an activation key or license key (a key that must be entered to activate 
the Product, “Activation Key”). If the Activation Key for a Product is not activated within five (5) 
years from the date of issuance by SonicWALL, such Activation Key(s) may expire and no 
longer activate the Product. Products that come with an expiring Activation Key will operate for 
the contracted term of the License (or purchased Security Service), so long as the Activation 
Key is activated within five (5) years from SonicWALL’s date of issuance.

2. OWNERSHIP

SonicWALL and its licensors are the sole and exclusive owners of the Software, and all 
underlying intellectual property rights in the Hardware. All rights not expressly granted to 
Customer are reserved by SonicWALL and its licensors.

3. TERMINATION OF LICENSE(S)

All licenses to the Software hereunder shall terminate if Customer fails to comply with any of 
the provisions of this Agreement and does not remedy such breach within thirty (30) days after 
receiving written notice from SonicWALL. Customer agrees upon termination to immediately 
cease using the Software and to destroy all copies of the Software which may have been 
provided or created hereunder.

4. SUPPORT SERVICES

SonicWALL’s current Support Service offerings (“Support Services”) and the terms and 
conditions applicable to such Support Services are set forth in SonicWALL’s Support Services 
Terms located http://www.sonicwall.com/us/support/ Services.html and are incorporated herein 
by reference. Support Services may require an additional fee. Unless otherwise agreed to in 
writing, SonicWALL’s Support Services are subject to SonicWALL’s Support Services Terms 
which are in effect at the time the Support Services are purchased by Customer, and these 
terms and conditions will be incorporated herein by reference at that time. SonicWALL reserves 
the right to change the Support Services Terms from time to time by posting such changes on 
its website, which shall apply to any Support Services purchased on or after the date of such 
posting.

5. SONICWALL WARRANTY

(a) Warranty. SonicWALL warrants to Customer (original purchaser Customer only) that for the 
applicable warranty period (“Warranty Period”) the Hardware will be free from any material 
defects in materials or workmanship and the Software, if any, will substantially conform to the 
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Documentation applicable to the Software and the License purchased (“Limited Warranty”). 
Except as may indicated otherwise in writing by SonicWALL, the Warranty Period for Hardware 
is one year from the date of registration of the Hardware Product (or if sooner, seven days after 
initial delivery of the Hardware Product to Customer), and the applicable warranty period for 
Software is ninety days from the date of registration of the Software Product (or if sooner, seven 
days after initial delivery/download) of the Software Product to/by Customer. SonicWALL does 
not warrant that use of the Product(s) will be uninterrupted or error free nor that SonicWALL will 
correct all errors. The Limited Warranty shall not apply to any non-conformance (i) that 
SonicWALL cannot recreate after exercising commercially reasonable efforts to attempt to do 
so; (ii) caused by misuse of the Product or by using the Product in a manner that is inconsistent 
with this Agreement or the Documentation; (iii) arising from the modification of the Products by 
anyone other than SonicWALL; or (iv) caused by any problem or error in third party software or 
hardware not provided by SonicWALL with the Product regardless of whether or not the 
SonicWALL Product is designed to operate with such third party software or hardware. 
SonicWALL's sole obligation and Customer's sole and exclusive remedy under any express or 
implied warranties hereunder shall be for SonicWALL to use commercially reasonable efforts 
to provide error corrections and/or, if applicable, repair or replace parts in accordance with 
SonicWALL’s Support Services Terms. Customer shall have no rights or remedies under this 
Limited Warranty unless SonicWALL receives Customer’s detailed written warranty claim within 
the applicable warranty period.

(b) Disclaimer. EXCEPT FOR THE EXPRESS WARRANTIES SET FORTH ABOVE, TO 
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW SONICWALL HEREBY DISCLAIMS 
ON BEHALF OF ITSELF, ITS SUPPLIERS, DISTRIBUTORS AND RESELLERS ALL 
WARRANTIES, EXPRESS, STATUTORY AND IMPLIED, APPLICABLE TO THE PRODUCTS, 
SERVICES AND/OR THE SUBJECT MATTER OF THIS AGREEMENT, INCLUDING, BUT NOT 
LIMITED TO, ANY WARRANTY OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS 
FOR A PARTICULAR PURPOSE.

6. LIMITATION OF LIABILITY

The Products are not designed, manufactured, authorized or warranted to be suitable for use 
in any system where a failure of such system could result in a situation that threatens the safety 
of human life, including without limitation any such medical, life support, aviation or nuclear 
applications. Any such use and subsequent liabilities that may arise from such use are totally 
the responsibility of Customer, and all liability of SonicWALL, whether in contract, tort (including 
without limitation negligence) or otherwise in relation to the same is excluded. Customer shall 
be responsible for mirroring its data, for backing it up frequently and regularly, and for taking all 
reasonable precautions to prevent data loss or corruption. SonicWALL shall not be responsible 
for any system downtime, loss or corruption of data or loss of production. NOTWITHSTANDING 
ANYTHING ELSE IN THIS AGREEMENT OR OTHERWISE, TO THE MAXIMUM EXTENT 
PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL SONICWALL, ITS SUPPLIERS, 
DISTRIBUTORS OR RESELLERS BE LIABLE FOR ANY INDIRECT, INCIDENTAL, PUNITIVE 
OR CONSEQUENTIAL DAMAGES, LOST OR CORRUPTED DATA, LOST PROFITS OR 
SAVINGS, LOSS OF BUSINESS OR OTHER ECONOMIC LOSS OR COSTS OF 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, ARISING OUT OF OR RELATED 
TO THIS AGREEMENT, THE PRODUCTS OR THE SERVICES, WHETHER OR NOT BASED 
ON TORT, CONTRACT, STRICT LIABILITY OR ANY OTHER LEGAL THEORY AND 
WHETHER OR NOT SONICWALL HAS BEEN ADVISED OR KNEW OF THE POSSIBILITY OF 
SUCH DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, 
SONICWALL'S MAXIMUM LIABILITY TO CUSTOMER ARISING FROM OR RELATING TO 
THIS AGREEMENT SHALL BE LIMITED TO THE AMOUNTS RECEIVED BY SONICWALL 
FOR THE PRODUCTS AND THE SERVICES PURCHASED BY CUSTOMER, PROVIDED 
THAT WHERE ANY CLAIM AGAINST SONICWALL RELATES TO PARTICULAR PRODUCT 
AND/OR SERVICES, SONICWALL’S MAXIMUM LIABILITY SHALL BE LIMITED TO THE 
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AGGREGATE AMOUNT RECIEVED BY SONICWALL IN RESPECT OF THE PRODUCTS 
AND/OR SERVICES PURCHASED BY CUSTOMER AFFECTED BY THE MATTER GIVING 
RISE TO THE CLAIM. (FOR MAINTENANCE SERVICES OR A PRODUCT SUBJECT TO 
RECURRING FEES, THE LIABILITY SHALL NOT EXCEED THE AMOUNT RECEIVED BY 
SONICWALL FOR SUCH MAINTENANCE SERVICE OR PRODUCT PURCHASED BY 
CUSTOMER DURING THE TWELVE (12) MONTHS PRECEDING THE CLAIM). CUSTOMER 
EXPRESSLY AGREES TO THE ALLOCATION OF LIABILITY SET FORTH IN THIS SECTION, 
AND ACKNOWLEDGES THAT WITHOUT ITS AGREEMENT TO THESE LIMITATIONS, THE 
PRICES CHARGED FOR THE PRODUCTS AND SERVICES WOULD BE HIGHER.

7. GOVERNMENT RESTRICTIONS

Customer agrees that it will not export or re-export the Products without SonicWALL's prior 
written consent, and then only in compliance with all requirements of applicable law, including 
but not limited to U.S. export control regulations. Customer has the responsibility to obtain any 
required licenses to export, reexport or import the Products. Customer shall defend, indemnify 
and hold SonicWALL and its suppliers harmless from any claims arising out of Customer’s 
violation of any export control laws relating to any exporting of the Products. By accepting this 
Agreement and receiving the Products, Customer confirms that it and its employees and agents 
who may access the Products are not listed on any governmental export exclusion lists and will 
not export or re-export the Products to any country embargoed by the U.S. or to any specially 
denied national (SDN) or denied entity identified by the U.S. Applicable export restrictions and 
exclusions are available at the official web site of the U.S. Department of Commerce Bureau of 
Industry and Security (www.bis.doc.gov). For purchase by U.S. governmental entities, the 
technical data and computer software in the Products are commercial technical data and 
commercial computer software as subject to FAR Sections 12.211, 12.212, 27.405-3 and 
DFARS Section 227.7202. The rights to use the Products and the underlying commercial 
technical date and computer software is limited to those rights customarily provided to the 
public purchasers as set forth in this Agreement. The Software and accompanying 
Documentation are deemed to be "commercial computer software" and "commercial computer 
software documentation," respectively, pursuant to DFAR Section 227.7202 and FAR Section 
12.212, as applicable. Any use, modification, reproduction, release, performance, display or 
disclosure of the Software and accompanying Documentation by the United States Government 
shall be governed solely by the terms of this Agreement and shall be prohibited except to the 
extent expressly permitted by the terms of this Agreement.

8. GENERAL

a) Governing Law and Venue. This Agreement shall be governed by and construed in 
accordance with the laws of the State of California, without giving effect to any conflict of laws 
principles that would require the application of laws of a different state. The parties agree that 
neither the United Nations Convention on Contracts for the International Sale of Goods, nor the 
Uniform Computer Information Transaction Act (UCITA) shall apply to this Agreement, 
regardless of the states in which the parties do business or are incorporated. Any action 
seeking enforcement of this Agreement or any provision hereof shall be brought exclusively in 
the state or federal courts located in the County of Santa Clara, State of California, United 
States of America. Each party hereby agrees to submit to the jurisdiction of such courts. 
Notwithstanding the foregoing, SonicWALL is entitled to seek immediate injunctive relief in any 
jurisdiction in the event of any alleged breach of Section 1 and/or to otherwise protect its 
intellectual property.

b) Assignment. Except as otherwise set forth herein, Customer shall not, in whole or part, 
assign or transfer any part of this Agreement or any rights hereunder without the prior written 
consent of SonicWALL. Any attempted transfer or assignment by Customer that is not permitted 
by this Agreement shall be null and void. Any transfer/assignment of a License that is permitted 
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hereunder shall require the assignment/transfer of all copies of the applicable Software along 
with a copy of this Agreement, the assignee must agree to all terms and conditions of this 
Agreement as a condition of the assignment/transfer, and the License(s) held by the transferor 
Customer shall terminate upon any such transfer/assignment.

c) Severability. If any provision of this Agreement shall be held by a court of competent 
jurisdiction to be contrary to law, such provision will be enforced to the maximum extent 
permissible and the remaining provisions of this Agreement will remain in full force and effect.

d) Privacy Policy. Customer hereby acknowledges and agrees that SonicWALL’s performance 
of this Agreement may require SonicWALL to process or store personal data of Customer, its 
employees and Affiliates, and to transmit such data within SonicWALL or to SonicWALL 
Affiliates, partners and/or agents. Such processing, storage, and transmission may be used for 
the purpose of enabling SonicWALL to perform its obligations under this Agreement, and as 
described in SonicWALL’s Privacy Policy (www.SonicWALL.com/us/Privacy_Policy.html, 
“Privacy Policy”) and may take place in any of the countries in which SonicWALL and its 
Affiliates conduct business, including countries outside of the European Economic Area. 
SonicWALL reserves the right to change the Privacy Policy from time to time as described in 
the Privacy Policy.

e) Notices. All notices provided hereunder shall be in writing, delivered personally, or sent by 
internationally recognized express courier service (e.g., Federal Express), addressed to the 
legal department of the respective party or to such other address as may be specified in writing 
by either of the parties to the other in accordance with this Section.

f) Disclosure of Customer Status. SonicWALL may include Customer in its listing of customers 
and, upon written consent by Customer, announce Customer's selection of SonicWALL in its 
marketing communications.

g) Waiver. Performance of any obligation required by a party hereunder may be waived only by 
a written waiver signed by an authorized representative of the other party, which waiver shall 
be effective only with respect to the specific obligation described therein. Any waiver or failure 
to enforce any provision of this Agreement on one occasion will not be deemed a waiver of any 
other provision or of such provision on any other occasion.

h) Force Majeure. Each party will be excused from performance for any period during which, 
and to the extent that, it is prevented from performing any obligation or service as a result of 
causes beyond its reasonable control, and without its fault or negligence, including without 
limitation, acts of God, strikes, lockouts, riots, acts of war, epidemics, communication line 
failures, and power failures.

i) Audit. Customer shall maintain accurate records to verify compliance with this Agreement. 
Upon request by SonicWALL, Customer shall furnish (a copy of) such records to SonicWALL 
and certify its compliance with this Agreement.

j) Headings. Headings in this Agreement are for convenience only and do not affect the 
meaning or interpretation of this Agreement. This Agreement will not be construed either in 
favor of or against one party or the other, but rather in accordance with its fair meaning. When 
the term “including” is used in this Agreement it will be construed in each case to mean 
“including, but not limited to.”

k) Entire Agreement. This Agreement is intended by the parties as a final expression of their 
agreement with respect to the subject matter hereof and may not be contradicted by evidence 
of any prior or contemporaneous agreement unless such agreement is signed by both parties. 
In the absence of such an agreement, this Agreement shall constitute the complete and 
exclusive statement of the terms and conditions and no extrinsic evidence whatsoever may be 
introduced in any judicial proceeding that may involve the Agreement. This Agreement 
represents the complete agreement and understanding of the parties with respect to the subject 
matter herein. This Agreement may be modified only through a written instrument signed by 
both parties.
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